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Preface

This documentation describes how to create and maintain business services with the optional
Business Service component of NaturalONE. It is organized under the following headings:

Release Notes Information on new features and enhancements.

What is the Business Service Brief description of this NaturalONE component.

Component

Before You Start Information on how to set up a Natural Business Services environment

and a testing environment.

Getting Started Step-by-step instructions on how to create a business service, steplib
and domain, and how to download business services from the server.

Service Development Detailed descriptions of all service development tasks.
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I Release Notes

These Release Notes pertain to the Business Services component of NaturalONE version 8.3. The
following topics are covered:

What's New in Version 8.2.1
What's New in Version 8.2.2
What's New in Version 8.2.3
What's New in Version 8.2.4
What's New in Version 8.2.5
What's New in Version 8.2.6
What's New in Version 8.2.7







1 What's New in Version 8.2.1
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What's New in Version 8.2.1

This section describes the changes to the Business Services component in version 8.2.1. The following
topics are covered:

Enhancements

This section describes the changes in this release of the Business Services component. The following
topics are covered:

= Java Client Generation
= Natural Server View
= Security View

Java Client Generation

The style of Java clients generated for business services has changed. Previous clients will continue
to function correctly, but new clients will be generated using a different style that uses EntireX
RPC directly instead of requiring the generation of an EntireX RPC wrapper. All Java client gen-
eration details are now provided in this guide; they are no longer documented in the Java Wrap-
per/Web Service Wrapper sections of the EntireX documentation. For information, see Generate
a Java Client.

Natural Server View

The Add from Server wizard has been replaced with standard Natural Server view functionality.
You can now add business services to a local project directly from the Natural Server view. For
information, see Downloading Business Services from the Server.

Security View

The NBS Security view is now available and you can apply security at a domain, business service,
and/or method level. The NBS Security view is linked to the Navigator and Natural Server views;
as you select different domains or children of domains, the views will change accordingly. For
information, see Setting Security Privileges.

4 Business Services



What's New in Version 8.2.1

Known Issues

This section describes the known issues in this release of the Business Services component. The
following topics are covered:

= QOption to Move Business Services between Domains
= Support for Redefined Fields
= Java Client Generation when PDA Fields Contain Direction Modifier Comments

Option to Move Business Services between Domains

Currently, you cannot move or copy a business service from one domain to another. If you do, an
error will occur and the service will appear to be in the old domain.

Support for Redefined Fields

When creating Java classes or Web services, redefined fields are not supported and the original
field will be used. This behavior is not consistent with Natural Business Services 5.n installations,
which support redefined fields.

Java Client Generation when PDA Fields Contain Direction Modifier Comments

When generating a Java client from a business service (.bsrv file), ensure the underlying Natural
subprogram data areas do not contain direction modifier comments in the parameter fields, such
as"/*in" or "/* out" and the "BY VALUE" (IN direction) option. These are currently not supported.
If they are used, the resulting generated code will contain compile errors.

Business Services 9






2 What's New in Version 8.2.2
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What's New in Version 8.2.2

This section describes the changes to the Business Services component in version 8.2.2. The following
topics are covered:

Enhancements

This section describes the changes in this release of the Business Services component. The following
topics are covered:

= Perform Actions on Business Service Resources
= Redesign the Interface during Java Client Generation

Perform Actions on Business Service Resources

You can now use the Natural Server view to perform standard actions on business service resources
on the server. For information, see Perform Standard Actions on Business Service Resources.

Redesign the Interface during Java Client Generation
When using the Java client generation wizard, you can now redesign the interface (for example,

select which portion of a redefined field to use for a Web service). For information, see Generate
a Java Client.
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3 What's New in Version 8.2.3

This version contains several error corrections. New functionality is not provided.
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4 What's New in Version 8.2.4

= Enhancements
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What's New in Version 8.2.4

This section describes the changes to the Business Services component in version 8.2.4. The following
topics are covered:

Enhancements

This section describes the changes in this release of the Business Services component. The following
topics are covered:

= New Preferences for Business Services
= Support for WS-Security in Generated Java Code
= Run a Dynamic RPC Java Class

New Preferences for Business Services

Using the new Installation preference page, you can control whether or not UI functions are visible
(for example, context menu actions and Natural Server view nodes), based on the availability of
Business Services on the Natural server. For information, see Set Installation Preferences.

Support for WS-Security in Generated Java Code

The generated Java code now supports WS-Security. When WS-Security is enabled for a Web
service and credentials are passed in the SOAP header, they will be used to issue the call to Broker.
For information, see Configure the Web Service to Use WS-Security.

Run a Dynamic RPC Java Class

You can now set the nbs.properties file to run a dynamic RPC Java class. For information, see Set
the nbs.properties File to Run a Dynamic RPC Java Class.

In addition, you can define different settings in the nbs.properties file for individual services and/or
groups of services. For information, see Define Different User IDs and Passwords for Web Services.

12 Business Services



5 What's New in Version 8.2.5

= Enhancements
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What's New in Version 8.2.5

This section describes the changes to the Business Services component in version 8.2.5. The following
topics are covered:

Enhancements

This section describes the changes in this release of the Business Services component. The following
topics are covered:

= Changes to the Test Editors
= Changes to the Steplib Wizard When Natural Security is Installed

Changes to the Test Editors

All toolbar controls for the Test editors are now available in the editor toolbar. These controls were
previously located in the Eclipse toolbar.

Changes to the Steplib Wizard When Natural Security is Installed

When Natural Security is installed, you can now use the steplib wizard to copy the Natural Security
steplib definitions for a selected library when creating a new steplib chain. By default, the steplib
definitions for a project were copied to the NBS steplib when the corresponding project was not
secured and was not using Natural Security.

] Notes:

1. For information, see Generating a New Steplib.

2. To change the default steplib options, see Set Business Service Preferences.
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6 What's New in Version 8.2.6

This version contains several error corrections. New functionality is not provided.
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7 What's New in Version 8.2.7

This version contains several error corrections. New functionality is not provided.
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What is the Business Service Component
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8 What is the Business Service Component

Similar to how NaturalONE allows you to work with Natural objects in Eclipse, the Business
Service component for Natural ONE allows you to create and maintain business services in Eclipse.
You can then upload the generated components to the server.

Business services are grouped by domains, which define the following settings:

® Security permissions for one or more users

= A steplib chain file indicating where the Natural objects for a business service are stored
The services are created locally in a NaturalONE project using the business service wizard or
downloaded from a Natural Business Services installation by defining server connections in

NaturalONE and then using a wizard to select the services. You can also use a wizard to generate
clients for business services, such as Java clients and Web services.

J Note: To install the Business Service component, you must select Designer > NaturalONE

> Service Development in the installation tree for the installer.

The Business Service component supplied with NaturalONE provides the following functions:

21



What is the Business Service Component

T Mavigakor 53 =0
N I B
= '[é Iy ck-=daef, 1) Mew
= .settings Go Into
=& Matural-Libraries Open in Mew Window
=@ NEWLIE
& ErR =| Cony
E res
(8 spc 3 Delets
W=l natural Mave, ..
HEl project Rename...
£=g Impart. ..
7 Export. ..
£ Refresh

Close Project
Close Unrelated Projects

Exkract IDL. ..
Generate Jawa Clisnt...
Generate Web Service. ..

MaturalOME
Testing

Code Generation
@ Enable for Ajax Developer

‘B Upload

Rebuild Project

Report
Validate

Run As
Debug As
Profile As
Team
Compare With

Restore from Local History, ..

Web Services Stack,

Source
Configure

Properties

- rF v v v

Mewt Business Service. .,
Mew Domain,
Mew Steplib, ..

| Note: The Business Service component must be initiated from a NaturalONE project in the

NaturalONE perspective. For information, see the NaturalONE documentation.

Using the Business Service component, you can:
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What is the Business Service Component

Task Procedure

Download business services data from a Natural See Downloading Business Services from the
Business Services installation on the server. Server.

Create a new business service in NaturalONE. See Creating a New Business Service.
Generate a new domain. See Generating a New Domain.

Generate a new steplib. See Generating a New Steplib.
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= 10 Setting Up a Natural Business Services Environment .............cccvveeiiiiiieiiiiiee e

= 11 Setting Up @ TeSt ENVIFONMENT ...
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9 Before You Start

This part contains information on the prerequisites for using the Business Service component. The
following topics are covered:

Setting Up a Natural Business Services Environment

Setting Up a Test Environment
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10 Setting Up a Natural Business Services Environment

To use the Business Service component of NaturalONE, a Natural Business Services (NBS) envir-
onment must be available in the Natural Server view. Although business services can be generated
into a project connected to the local Natural runtime environment, they cannot be executed in the
NBS runtime environment.

NaturalONE only supports RPC servers. Natural Business Services version 5.3.1 service pack 4 or
higher is required to execute business services via the Natural RPC server.

J Notes:

1. Business services created on an RPC server can be used in other NBS environments (for example,
the Dispatch server environment).

2. For information on installing and configuring a Natural Business Services environment, see
Natural Business Services Installation on Mainframes.
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11 Setting Up a Test Environment

To test subprograms and business services directly, and to create unit tests for subprograms and
business services, a Natural RPC server is required. The Natural Development Server cannot be
used in this context. If you are testing items in a project connected to the local Natural runtime
environment, a special connection via RPC must be made.

] Note: Forinformation on testing business services and subprograms, see Application Testing.
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IV Getting Started

This part contains step-by-step instructions for the following topics:

Creating a New Business Service

Generating a New Steplib

Generating a New Domain

Downloading Business Services from the Server

Testing a Business Service
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12 Creating a New Business Service
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Creating a New Business Service

Create a Natural Project

Before creating a new business service, you must create a local project in which to generate the
business service data.

» To create a Natural project:

1 Open the NaturalONE perspective.

2 Select New > Natural Project on the File menu.

The Create a Natural Project window is displayed. For example:

7= New Matural Project |:|®

Create a Matural Project ﬁ

This wizard creates a Matural project

Project: | |

Create the library root Folder

@ Cancel

3 Type "NewProject" in Project.
4  Select Finish.

The new project is displayed in the Navigator view. For example:

T Mavigakor 27 =8
. - E % 15 15 >

'[é MeswPraoject- =daef . ha.sag-7307 (0)

5 Expand the NewProject node.

The standard project components are displayed. For example:
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Creating a New Business Service

T Mavigakor 53 =8

EE=] MewProject- =daef hg.sag-7
= .settings
& Matural-Libraries
W=l natural
Wl project

] Note: For more information on creating a Natural project, refer to the Natural ONE docu-

mentation.

Create a New Library

This section describes how to create a new library in which to store the new business service.

» To create the library:

1 Open the context menu for NewProject in the Navigator view.

2 Select New > Natural Library.

The Create a Natural Library panel is displayed. For example:

7= New Natural Librany |Z||E|E|
Create a Natural Library s
This wizard creates a Matural library
e -]
Project: | MewProject | [Brnwse... ]
Library: || |
Folder: | | [Brnwse...]

©

3 Type "NEWLIB" in Library.
4  Select Finish.
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Creating a New Business Service

The library is created locally.

5 Expand the Natural-Libraries node in the Navigator view.

The new library and sub-folders are displayed. For example:

T Mavigatar &3 =8

4
(m13]
L

R eviProject->daef hg.sag-7307 (1)
+-[Z= settings
=& Matural-Libraries
= (@ NEWLIE
2 Ern
& res
(& spc
W=l natural
NZ . project

Access the Business Services Functions

This section describes how to access the Business Services functions.

» To access the Business Services functions:

1 Open the context menu for NewProject in the Navigator view.

2 Select Business Services.

The Business Service functions are displayed. For example:
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Creating a New Business Service

T Mavigator &3

EEE]

= .setkings

=& Matural-Libraries

SR

MEWWLIE
 erp
& REs
{5 spo

Wzl natural

WE| .project

Go Inka
Open in Mew Window

= copy

¥ Delete

Mave...
Rename. ..

Fug Import...
£y Export...

& | Refresh

Zlose Project
Close Unrelated Projects

Extrack IDL. ..
Generate 1ava Client. ..
Generake Web Service. ..

MaturalONE
Testing

Code Generation

@ Enable For Ajax Developer

‘B Upload

Rehuild Project

Report
validate

Run As
Debug As
Profile As
Team
Compare with

Restore from Local History,

web Services Stack

Source
Configure

Properties

- v v w w

Mew Business Service. .,
Mew Domain...
Mew Steplib, ..

Business Services
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Creating a New Business Service

Generate the New Service

You are now ready to use the Business Service wizard to generate your business service. During
generation, the wizard also creates default objects required by the service, such as the domain and
steplib chain files. After generation, you can edit the default information about these objects as
required.

» To generate the new business service:

1  Open the context menu for NewProject in the Navigator view.

2 Select Business-Services > New Business Service.

The Define Business Service Details panel is displayed, showing the name of the project.
For example:

- = ] F
= New Business Service |- |@@

Define Business Service Details Tk
Enter the information needed to generate a new business service,

. -

Matural project name: | MewProject | lBerse... l

Business service details

Domain: | s |

Service name: | MewSeryvice |

Version: | 1.0.0 |

Descripkion:

@ Cancel

3  Select "NEWDOM" in Domain.

The domain will be created locally, along with an associated step library entry that points to
a steplib chain with the same name as the domain.

] Note: If you specify the name of an existing domain, the wizard will check the server

connection and download any required data from the NBS repository. Domain only
contains domain entries that have already been downloaded.
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Creating a New Business Service

4  Type "This is a new business service." in Description.

5  Select Next.

The Define Subprogram Type panel is displayed. For example:

7= New Business Service |._|@|PX|
Define Subprogram Type -
Choose the subprogran tvpe to be generated.
e -]

Please indicate the subprogram bvpe to be generated:
(#) Mone (do not generate subprograms)
(") Object browse
() Object maink
(") Object skeleton

@ Finish ] [ Cancel

| Note: By default, no subprograms are generated. For more information about creating

the subprogram types on this panel, see Code Generation.

6  Select Object browse.
7 Select Next.

The Define Object Browse Details panel is displayed.
8  Select "NEWLIB" in Library.
9 Type "MYBROWSE" in Name.
10  Select "NewProject/Natural-Libraries/NEWLIB/SRC/NCST-CUST.NSD" in DDM.

For example:
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Creating a New Business Service

— ] ]
= Hew Business Service

Define Object Browse Details

Enter the specifications For the Object Browse,

Specifications

Library: | MEWLIE

| ’Browse...l

Mame: | MYBROWSE

Descriphion: | This module is used For ...

ibject Browse file

DOM: | MewProject/Matural-Libraries MEWLIB)SRCINCST-CIUS.MSD

| [Browse...]

@

Finish

Cancel

11 Select Next.

The Change Defaults panel is displayed. For example:

— . ]
= Hew Business Service

Change Defaults
Change the defaults if required.

Ohject Browse component names

Object description: |

Object PDA: | MYERDAL

Object key PDA: | MVBRKAL

Restricted PDA: | MYERPAL

Ohject Browse Lnique Key

Primary key: |

@

Finish

Cancel

42
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Creating a New Business Service

This panel shows the default specification values for the browse subprogram to be generated.
Using this panel, you can:

Task Procedure

Change the name of the parameter data area (PDA)|Type the name in Object PDA.
for the object.

Change the name of the local data area (LDA) for |Type the name in Object LDA.

the object.
Note: The local data area is only required when

the hash-locking option is used for record locking.

Change the name of the restricted parameter data |Type the name in Restricted PDA.
area (PDA) for the object.

Define the primary key field used for browse Select the field in Primary key.
operations.

12 Type a description of the browse subprogram in Object description.

13 Select Finish to generate the business service file, the associated domain and steplib files, and
the corresponding Natural objects.

The generated items are added to NewProject and the new business service is now listed in
the Navigator view. For example:

T Wavigatar 3 =0

- % 15 =
= L:H MNewProject- >daef.hg.sag-7307 (1)
+[= ,settings
BREAELsiness-Services
=I-[= _steplibs
E MEWDOM,steplib
== MEWDM
[ .damain
{1 MewsService.w1.0.0.bsrv
+-[E& Matural-Libraries
.natural
X| .project

Details about the new service are displayed in the business service editor. For example:
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Creating a New Business Service

MYBROWSE MSM | [G3) NewService.v1.0.0.bsrv 54
Overview

w General Information

This section describes general information about this business service,

Domain: MEWDOM
Service: MewtService
Version: 1.0.0

Default pros: |

Default subprogram: |

Descripkion:

This is a new business service,

w Method List

This section lisks the methods
used by this business service,

BROWSE add

Remowve

Orvverviess | XML

The generated object-browse subprogram is displayed in the editor view. For example:
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Creating a New Business Service

I vvBROwSE.MSM 52 [5] NewService v1.0.0.bsry =0
B+ »Natural Source Header 0000000 ol
S*r3AG GENERATOR: OBJECT-BROWSE-N1 VERSION: 5.3.1

*F3AaG OBJECT-DEZC: Object EBrowse

®**S3AG OBJECT-WNAME: MYEBROWSE

#*¥3LG DDM: /NewProject/Natural-Libraries/S¥3TEN/SRC/NCIT-CUS . N3D

*ESAG ROW-FDA-WNAME: MYERDAL1

**SAG EEY-PDA-NAME: MYERELIL

**3AG RESTRICTED-FDA-WNAME: MYERFPL1

*HEIAG USE-MEG-NR: X E
*H5ALG DESCE (1) : This module is used for

*HEIAG HISTOGRAM(1): X

*EEAG PHYSICAL-KEY(1,1): CUSTOMER-NUMEEER —
*HEIAG HISTOGRAM(Z): XH

*ESAG PHYSICAL-KEY(2,1): BUIINESS-NLMNE

*HESAG HIZTOGRAM(S): XH

*ESAG PHYSICAL-EEY(3,1): CUSTOMER-WAREHOUSE-ID

*HEIAG HIZTOGRAM(4): X

**EAG PHYSICAL-KEEY(4,1): CUITOMER-TIMESTALMP =
e o o o o o o o o o =
% Program @ MYBROWSE

* Bystem : IY¥STEHM

* Title : Object Browse Subprogratm

* Generated: Thu Dec 24 16:31:51 E3T 2009

* Function : This module is used for

*

+*

*

* History

**3AG DEFINE EEIT CHANGE-HIZTORY

®**EAG END-EEIT

e o o o o o o o o o 3

14 Save the business service data.

D Notes:

1. By default, the settings defined in Properties > Natural > Steplibs on the context menu for
the project will be used as the default steplib chain.

2. You can upload the business service data to the server using standard NaturalONE func-
tionality. For information, see the NaturalONE documentation.

At this point, the business service has been created along with a default domain and steplib chain
(list of libraries that includes the step library containing the subprogram that implements the service
method). If required, you will now edit the default information for the domain and steplib files:

= Edit the Default Domain Information
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Creating a New Business Service

= Edit the Default Steplib Information
Edit the Default Domain Information

In this example, you will provide a brief description of the default domain generated by the
Business Service wizard.

» To edit the default domain information:

1  Expand the NEWDOM node in the Navigator view.

For example:

= v =8

T Mavigakor &2 == |

= '[5 MewProject- =daef.hq.sag-7307 (1)
== .settings
=I-[= Business-Services

t = _steplibs

== |
4. domain
[y Caloulator 1.1, bsry
ET_T] Caloulakorfdvance vl 1.1, bsry
[y Customerv1.1.1.bsry
ET_T] CustamerCreditAnalysis vl 1.1 bsry
[y CustomerwithContactData,vi.1.1.bsry
ET_T] CustamerWithContactData, w2, 1.1, bsry
|_—@ ErrorMessageTesting.w1.1.1.bsry
ET_T] FlipString.w1.1.1.bsry
|_—@ GreatestCommonDenominator 1,1, 1, bsry
ET_T] Order vl 1.1 bsry
[y Order vz, 1.1, bsry
ET_T] Product,«1.1.1.bsry
|_—@ SkringManipulation. 1.1, 1. bsrv
ET_T] Warehause,v1.1.1.bsry
|_—@ rarravBaseballPlayers.wl,1.1.bsrv

2 Open the .domain file.

The domain editor is displayed. For example:
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. domain E2 =8

Overview

« General Information
This section describes general information about this domain,

Ciornain: DEMC

Description: | Demo domain

Steplib chain: | DEMO Z

Orepview | WML

3  Type "This domain contains the sample business service." in Description.

4  Save the domain file.

| Note: You can upload the domain file to the server using standard NaturalONE func-
tionality. For information, see the NaturalONE documentation.

Edit the Default Steplib Information

In this example, you will provide the database ID and file number for the default steplib chain
generated by the Business Service wizard.

» To edit the default steplib information:

1  Expand the _steplibs node in the Navigator view.

For example:

T Mavigakor &3 — Q:f; o = =0
= '[5 MewProject- =daef.hq.sag-7307 (1)

+-[= settings

=I-[= Business-3ervices

=4 steplibs
B NEWDOM,steplib
+- = MEWDOM
+-[E Natural-Libraries
.natural
X .project

2 Open the NEWDOM .steplib file.

The steplib editor is displayed. For example:
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B MEWDOM,steplib 532

Overview

= General Information

This section describes general information about this skeplib chain,

Steplib: MEWDOM
+ Library List

This section lists the step libraries within this steplib
chain.

MEWDOM
Rermone

P

Craneiry

Crverview | BML

A step library with the same name as the steplib chain is displayed in the Library List section.

(  Tip: The settings defined in Properties > Natural > Steplibs on the context menu for

the project can be used to populate the Library List.

3  Select NEWDOM in the Library List section.

The Library Information section is displayed. For example:
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»

E\E]NewService.vl.D.D.bs [~ .domain B *MEWDOM.steplb 53 1 =8
Overview

= General Information
This section describes general information about this skeplib chain,

Steplib: NEWDOM

+ Library List + Library Information
This section lists the step libraries within this This section describes library information.
steplib chain,

Library name: | NEWDOM
MEWDOM

Library DEID: | 0
Remave Library FMNR: | 0

P

Craneiry

Crverview | aML

| Note: The DBID and FNR values are not required; they are only used in advanced
configurations when uploading to the server.

4  Save the steplib file.
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13 Generating a New Steplib

This section describes how to generate a new steplib chain for your business services. This file
defines a set of Natural libraries that a business service dispatch server must access to call a sub-
program or proxy. The dispatch server accesses the libraries in the order they are listed in the
steplib file.

» To create a new steplib:

1 Open the context menu for NewProject in the Navigator view.

2 Select Business-Services > New Steplib.

The Define Steplib Details panel is displayed. For example:
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72 New Steplib =3
Define Steplib Details g
Enter the information needed to generate a new business service steplib,
. -
Matural project name: | MewProject | lBerse... l

Steplib details
Mame: | NEW_STEPLIE| |

Copy Matural Security skeplib definitions

@ Finish l [ Zancel

3  Type "NEWSL" over the default name in Name.
4  Select Finish to generate the steplib file.

The generated items are added to your project and the new steplib is now listed in the Navig-
ator view. For example:

T Mavigakor 27 | =] <'1=’=f> 18 ¥ =8

-l MewProjeck- >daef hg.sag-7307 (1)
= .settings
== Busingss-Services
== _steplibs
B NEWDOM,steplib
=l 1w sl steplib
== NEWDOM
£ domain
MNewService, v1,0.0.bsry
(& Natural-Libraries
=] .natural

% .praject

The steplib file is displayed in the editor view. For example:
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b

HER MYBROWSE SN B #*MEWSL.steplib 53 = B8

Overview

w General Information
This section describes general information about this steplib chain,

Skeplib: WEWSL

w Library List
This section lists the step libraries within
this steplib chain.

Remove

P

Chaneiny

Cvverviess | XML

¢ Tip: The settings defined in Properties > Natural > Steplibs on the context menu for
the project can be used to populate the Library List.

5  Select Add.

The Library Information section is displayed. For example:

Business Services
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HER MYBROWSE SN B #*MEWSL.steplib 53 =8

Overview

w General Information
This section describes general information about this steplib chain,

Skeplib: WEWSL

w Library List w Library Information

This section lists the step libraries within This section describes library information,
this steplib chain.
Library name: | LIBRARY1
LIBRARY1
Library DEID: |0

Remave Library FNR: | 0
P

Chaneiny

Cvverviess | XML

6  Type "MYLIB" over the default name in Library name.

| Note: The DBID and FNR values are not required; they are only used in advanced

configurations when uploading to the server.

7  Select Add.
8  Type "SYSTEM" over the default name in Library name.

The MYLIB and SYSTEM step libraries are now part of the NEWSL steplib chain. For example:
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B *pnEWSL,steplib 52 =0

Overview

+ General Information
This section describes general information about this skeplib chain,

Steplib: MEWSL

w Library List w Library Information
This section lists the step libraries within This section describes library
this skeplib chain, information,

add Library name: | S¥ITEM |

— Library DEID: | 0 |

Library FHR: | 0 |

1

Diown

Crverview | BML

9  Save the steplib file.
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14 Generating a New Domain

This section describes how to generate a new domain for your business services. Each business

service is assigned to a domain, which groups the services according to access privileges and user-

defined criteria.

» To create a new domain:

1  Open the context menu for NewProject.

2 Select Business-Services > New Domain.

The Define Domain Details panel is displayed. For example:

- =
= Hew Domain

Define Domain Details

Enter the information needed to generate a new business service domain,

Matural project name: | MewProject

Domain details

Mame: |
Description: | |
Steplib: | NEWDOM v/
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3 Type "MYDOM" in Name.

| Note: The wizard will check the server connection to verify whether the domain cur-

rently exists. If it does, a message is displayed. You can either overwrite the existing
domain or enter a new name.

4  Type "This is the new domain for my business service." in Description.
5  Select "NEWSL" in Steplib.

6  Select Finish to generate the domain file.

The generated items are added to your project and the new domain is now listed in the Nav-
igator view. For example:

T Mavigakor &2 == ¥ =0

= '[5 MewProject- =daef.hq.sag-7307 (1)
== .settings
=I-[= Business-3ervices
== _steplibs
B NEWDOM,steplib
E NEWSL steplib
il
[ .domain
= [ = MEWDOM
[ .domain
MNewService v1,0.0,bsry
#1585 Matural-Libraries
.natural
K| .project

The domain is displayed in the editor view. For example:

TR MYBROWSE. NSN Bt *MEWSL.steplib ) domain &2 =8

Overview

-0
This section describes general information about this damain,
Dornain: MY DM

Description: | This is the new darmain Far my business service.,

Steplib chaing | MEWSL I

Crverview | BML

7  Save the domain file.
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15 Downloading Business Services from the Server

This section describes how to download business services data from a Natural Business Services
installation on the server to the local environment. This procedure is performed in two parts: first
map to an existing business service installation on the server and then download the services from
the Natural Server view to the Navigator view.

» To map to an existing Natural Business Services installation:

Select “on the toolbar in the Natural Server view.

The Map a Natural Server Environment panel is displayed. For example:

7= Map Environment

Map a Natural Server Environment m

Specify the mapping parameters For the Matural Server,

Matural server connection

Haost name: | |

Port number: | |

Enwironment name: | |

Skartup

Session parameters: | |

User ID: | |

Password: | |

7 Fimish Cancel
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2 Type the name of the host for the Natural Business Services installation in Host name.

3  Type the port number in Port number.
The name of the environment is derived from the host and port values and displayed in En-
vironment name when you select the field. You can change this name if desired.

4  Type the Natural profile name for the environment in Session parameters.

5 Type the user credentials for the server in User ID and Password.

6  Select Finish.

The connection is displayed in the Natural Server view. Expand the connection node to see
the contents. For example:

= =
=F Matural Server 57 - | = ® |3 T O

= "JT: daef .hg.sag-7307
+- = Business-Servicas
+-[= Construct
+ l:[j |Jser Libraries
+ [ System Libraries
+ [l ooms

» To download business services from the Natural Server view to the Navigator view:

1 Open the context menu for the Business-Services root node in the Natural Server view.
Or:

Expand the root node and select one or more steplib and/or domain nodes or files using
standard selection techniques.

2 Select Add to existing Project.

For example:

L] ex ] —*l, (=]
=M Matural Server 23 =] | =5 - O

= "JT: daef .hg.sag-7307

=IMNE ICES
Skeplibs
+-[= Domains

= Construct

Q) User Libraries & | Refresh =3

0 System Libraries

Cf ooms

+

|

Properties
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A list of available projects is displayed. For example:

- = ] ] = =
= Add Business services resources to existing project

Select Project:

1= ConstructRuntime
I;'NvNewProject
L';—NfSampleProject

@j [w]'s l [ Cancel

3  Select NewProject.
4 Select OK.
A progress window is displayed as the business services are downloaded from the server to

the local project in the Navigator view. Expand the Business-Services root node to display
the downloaded business services. For example:

T Mavigakor 27 2 BE| &%~ -0
o (o [— @

= .settings
== Busingss-Services
= _steplibs
= [= DEMO
4. domain

[y Caloulator 1.1, bsry

&] Caloulakorfdvance vl 1.1, bsry

[y Customerv1.1.1.bsry

&] CustamerCreditAnalysis vl 1.1 bsry
[y CustomerwithContactData,vi.1.1.bsry
&] CustamerWithContactData, w2, 1.1, bsry
@ ErrorMessageTesting.w1.1.1.bsry

&] FlipString.w1.1.1.bsry

@ GreatestCommonDenominator 1,1, 1, bsry
&] Order vl 1.1 bsry

[y Order vz, 1.1, bsry

&] Product,«1.1.1.bsry

@ SkringManipulation. 1.1, 1. bsrv

&] Warehause,v1.1.1.bsry

@ rarravBaseballPlayers.wl,1.1.bsrv
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16 Testing a Business Service

You can test a business service or subprogram directly and/or create unit tests for business services
and subprograms. For information, see Application Testing.
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V Service Development

This part covers the following topics:

Creating a New Business Service

Generating a New Domain

Generating a New Steplib

Editing Information about an Existing Business Service
Generating Java Clients and Web Services

Setting Preferences for Business Services

Setting Security Privileges
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17 Creating a New Business Service

= Create a NaturalONE Project ..............cceeee.
= Create the Business Service ............cccccevvvnne

= Add Business Service Definitions to CentraSite
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Creating a New Business Service

This section describes how to create a new business service. The Business Service wizard quickly
generates the business service based on a few simple input values. In addition, the wizard generates
default objects required by the service. These include:

Object Generated |Description

Domain file Groups business services and defines the boundaries of a business service. Each business
service is assigned to a domain.

Steplib chain file | Defines a set of Natural libraries that a business service dispatch server must access to
call a subprogram or proxy. The dispatch server accesses the libraries in the order they
are listed in the steplib file.

Note: By default, the generated steplib will contain the libraries listed in Properties >

Natural > Steplibs on the context menu for the project.

Methods list Lists the methods used for this business service. The type of methods listed depends on
the type of service generated.

After generating a business service, you can edit the default information that was generated for
the objects.

] Notes:

1. You cannot change the key fields, such as the file or domain names.

2. Always use the corresponding editors (business service, domain, and steplib) to edit business
services files. Manually editing these files outside of the editors or NaturalONE perspective
can potentially cause problems. The XML tab attached to these editors can only be used to view
the underlying XML file.

This section covers the following topics:

Create a NaturalONE Project

All business service components are stored locally in a NaturalONE project. If you do not want
to use an existing NaturalONE project to store the new business service, you can create a new
project. For information, see the NaturalONE documentation.

The following example shows the Business Services folder structure within a NaturalONE project:

® NaturalONE_project_name
" Business_Services
= _steplibs
"= steplibl.steplib
= steplib2.steplib

68 Business Services



Creating a New Business Service

* DOMAIN1

" domain

® BusinessServicel.v1.0.0.bsrv

" BusinessService2.v1.0.0.bsrv

* DOMAIN2

" domain

® BusinessService3.v1.0.0.bsrv

" BusinessService4.v1.0.0.bsrv

These folders and files are:

Folder/File

Description

Business_Services
folder

Top-level folder with a static name that stores all business service-related files. This
folder can be deleted (which deletes all business service-related files within it), but
must not be renamed.

_steplibs folder Top-level folder with a static name that stores all steplib chains (.steplib files). This
folder can be deleted (which deletes all steplib files within it), but must not be
renamed.

*steplib file XML representation of a steplib. Use this file to perform steplib-related operations

(delete, edit using the Steplib editor, upload to the Natural server using the Upload
command, etc.). This file must not be renamed.

DOMAIN_NAME folder

Folder with the name of the domain to make it visually easier to see the business
services within the domain. The actual XML representation of a domain is the .domain
file located within this folder. This folder can be deleted (which deletes all business
services files within it), but must not be renamed.

.domain file

XML representation of a domain. You interact with this file to perform domain-related
operations (i.e., edit the file using the domain editor and upload the file to the Natural
server using the Upload command). This file must not be renamed.

Note: To delete a domain, you must delete the domain folder (you cannot delete the

.domain file only).

* bsrv file

XML representation of a business service. You interact with this file to perform
business service-related operations (delete, edit using the business service editor,
upload to the Natural server using the Upload command, Test, etc.). This file must
not be renamed.

Business Services
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Create the Business Service

This section describes how to create a new business service in a NaturalONE project. Once a
business service has been generated, you can provide further details about the service, its domain,
and its steplib chain. This section covers the following topics:

= Generate the Business Service

= Define the Domain Information

= Define the Steplib Chain Information

= Create a Step Library

= Add a Step Library to the Steplib Chain

= Create the Subprogram to Implement a Method
= Add a Method

= Test the Business Service and Subprograms

= Use the Dependencies View

] Note: The business service file is created locally. Use standard NaturalONE functionality
to upload the file to the server.

Generate the Business Service

» To generate the new business service:

1 Open the context menu for the project.

2  Select Business-Services > New Business Service.

The Define Business Service Details panel is displayed, showing the name of the project.
For example:
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- = ] F
= New Business Service |- |@@

Define Business Service Details Tk
Enter the information needed to generate a new business service,

. -

Matural project name: | MewProject | lBerse... l

Business service details

Domain: | s |

Service name: | MewSeryvice |

Version: | 1.0.0 |

Descripkion:

@ Cancel

] Note: If this is not the project into which you want to generate the service, select Browse
to choose a different NaturalONE project.

3 Provide the name of the domain that will contain your business service in Domain as follows:

® Type the name of the domain in Domain.

= If the domain currently exists on the server and the NaturalONE project is associated
with a server connection, the domain and steplib files will be downloaded when you select
Finish on this panel.

| Note: This functionality can be modified in the Preferences window for business

services. For information, see Set Business Service Preferences.

= If the domain is new, it will be created locally along with an associated step library entry
that points to a steplib chain with the same name as the domain.

] Note: If required, you can edit the generated entries. For information, see Define
the Domain Information and Define the Steplib Chain Information.

" Select the name of a domain that is currently in the local Natural ONE project from Domain.

4  Type the name of the new service in Service name.

5  Type the version number for the service in Version.
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In this case, the version is 1.0.0.
6  Type a brief description of the service in Description.

7 Select Finish to generate the business service file (and possibly the associated domain and
steplib files).

Or:
Select Next to also generate the Natural objects for the business service.

The Define Subprogram Type panel is displayed.

7= Mew Business Service |:|@|gl

Define Subprogram Type |
Choose the subprogran tvpe to be generated.
e d

Please indicate the subprogram bvpe to be generated:
(#) Mone (do not generate subprograms)
(") Object browse
() Object maink
(") Object skeleton

@ Finish ] [ Cancel

8  Select the subprogram type to be generated.

By default, no subprograms are generated. To generate a subprogram, select the type on this
panel and select Next. The corresponding wizard is displayed to define the parameters for
the subprogram.

| Note: For more information about the subprogram types on this panel, see Code Gener-

ation.

9  Select Finish to generate the business service file and possibly the associated domain and
steplib files, along with the corresponding Natural objects.

The generated items are added to your NaturalONE project and the new business service is
now listed in the Navigator view. For example:

72 Business Services



Creating a New Business Service

T Wavigator £ =8

|
iy
&
=

q

= MewProject-=
+ =5 setkings

== _steplibs

B NEWDOM.steplib
=& NEWDOM

[ .domain

[@ MewService,w1,0.0.bsry

Details about the new service are displayed in the editor view. For example:

[+ Mewseryice, v1,0.0,bsry £3
Overview

= General Information

This section describes general information about this business service,

Darnain: MEWDOM
Service: MewService
Wersion: 1.0.0

Default proxy:

Default subprogram:

Description: & brief description of the business service,

= Method List

This section lists the methods used
by this business service,

Default

Crverview | BML

Use this editor to provide a default name for the business service subprogram and proxy.

| Note: You must specify a default subprogram for the service if any of the methods do
not specify a subprogram.

10 Save the business service.
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Define the Domain Information

» To define the domain information:

1  Expand the domain node for the business service in the Navigator view.

2 Open the .domain file for the business service.

The domain editor is displayed. For example:

[ Mewservice.v1.0,0,bsry #.. . domain &3

Overview

= General Information
This section describes general information about this damain,

Damain: MEWDOM

Description: | This domain. ..

Steplib chaing | MEWDOM I

Crverview | BML

Using this editor, you can:

Task Procedure

Provide a description of the domain. Type a brief description in Description.

Change the default name of the steplib chain (list of libraries| Type or select the name of the steplib chain
that includes the step library containing the subprogram |in Steplib.
that implements the service method).

3  Save the domain.
] Notes:

1. You can upload the domain file to the server using standard Natural ONE functionality.

2. For more information on domains, see Defining Steplibs and Domains, Natural Business Services
Administration.
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Define the Steplib Chain Information

This section describes how to define the list of step libraries in the steplib chain used for the business
service.

» To define the steplib chain information:

1  Expand the step library node in the Navigator view.
2 Open the SteplibName.steplib file.

The steplib editor is displayed, showing the name of the steplib chain in Steplib. For example:

[ ) MewService.v1.0.0.bs () * . domain Bt MEWDOM.steplb 22 ™3 |

Cverview

+ General Information
This section describes general information about this steplib chain.

Skeplib:  WEWDOM
 Library List

This section lisks the skep libraries within this steplib
chain.

MEW DM
Remowve

n

Down

Cvverviess | XML

The first step library in the Library List section has the same name as the steplib chain. You
can use this step library as a starting point when defining the steplib chain.

¢ Tip: The settings defined in Properties > Natural > Steplibs on the context menu for
the project can be used to populate the Library List.

Using this editor, you can:
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Task Procedure

Add a step library to the steplib chain. See Add a Step Library to the Steplib Chain.

Note: For information on creating a new step library,

see Create a Step Library.

Remove a step library from the steplib chain. |Select the library and then select Remove.

Reorder the list of step libraries within the |Select Up and Down to reorder the list.
steplib chain.

3 Save the steplib.

J Notes:

1. You can upload the steplib file to the server using standard NaturalONE functionality.

2. For more information on steplib chains, see Defining Steplibs and Domains, Natural Business Services
Administration.

Create a Step Library

» To create a step library:

1  Select New > Natural Library on the File menu.

The Create a Natural Library panel is displayed. For example:

¥ New Natural Library: |Z| [E| El

Create a Natural Library

This wizard creates a Matural library

Project: | MewProject | [Browse... ]
Library: || |
Falder: | | [Browse... ]

Q

2 Select the name of the NaturalONE project in Project.
3 Type the name of the step library in Library.
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4  Select Finish.
The library is created locally and displayed in the Navigator view.

| Note: You can upload the library to the server using standard Natural ONE functionality.

Add a Step Library to the Steplib Chain

» To add a step library to the steplib chain:

1  Expand the step library node in the Navigator view.
2 Open the SteplibName.steplib file.

The steplib editor is displayed, showing the name of the steplib chain in Steplib.
3 Select Add.

The Library Information section is displayed. For example:

b3

LiH) Mewservice.v1.0.0,bs [ *. domain Es *MEWDOM,steplib 53 3 =08

Overview

w General Information
This section describes general information about this steplib chain,

Steplib: - NEWDIOM

w Library List w Library Information
This section lists the step libraries within this steplib This section describes library information,
chain,
Library name: | LIBRARY1
MEWDOM

LIERARY1 Library DEID: | O
Remave Library FNR: | O

p

Diown

Cvverviess | XML

By default, LIBRARY1 is displayed in Library name.

| Note: The DBID and FNR values are not required; they are only used in advanced

configurations when uploading to the server.
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4  Type the name of the new library over the default name in Library name.

5  Save the steplib file.

] Note: For information on removing a step library from the steplib chain or reordering the
list of step libraries, see Define the Steplib Chain Information.

Create the Subprogram to Implement a Method

This subprogram will implement the logic for your new business service.

» To create the subprogram:

1  Select New > Subprogram on the File menu.

The Create a Natural Subprogram panel is displayed. For example:

7= New Natural Subprogram |:|@®

Create a Natural Subprogram =
This wizard creates a new subprogram object that can be opened by the Matural source editar.

[N -

Project: [l | |Browse... |
Library: | | |Browse... |
Folder: | | [Browse... |
Object typs:

Object name: | |

File name: | |

Programming rode: |Structured v

(2 Cancel

Select the name of the project in Project.
Select the name of the library in which to store the subprogram in Library.
Select the local folder in which to store the subprogram in Folder.

Type the name of the subprogram in Object name.

SN U1 =~ W DN

Type the name of the file in File name.
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| Note: By default, Structured is selected in Programming mode. If the subprogram will
use reporting mode, select Reporting.

7 Select Finish to create the subprogram.

The new subprogram is listed in the Navigator view. For example:

T Mavigatar &3 =0

= roject- =daef . hg,sag-7307 ()
= .settings
[=1-[= Business-Services
== _steplibs
B NEWDOM, steplib
=& NEWDOM
7 .domain
MNewService, v1,0.0.bsry
£ NEWLIB
2 err
E res
= spe
MEWSLIE NS
W=l natural
NZ . project

The subprogram is also displayed in the Natural editor. For example:

L) NewService v1.0.0bsrw | .domain B *MEWSER.steplit | [T NEWSUB.NSN 52 =0

P B »Natural Source Header 0000000
f* TODO: Enter your code here
END

8  Add logic to the subprogram.

9  Save the subprogram.
The subprogram is saved locally.

] Note: You can upload the subprogram to the server using standard NaturalONE

functionality.

You can now add a method to the business service.
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Add a Method

» To add a method to the business service:

1 Open the NewService.bsrv file in the Navigator view.

The business service is displayed in the editor view.

2  Select Add.

The Method Information section is displayed. For example:

Li1) MewsService,v1.0.0,bs *ewService.v1.0.0.6 2% [ *.domain Es *MEWDOM. steplib

Overview

= General Information
This section describes general information about this business service.

Damain: MEW DM
Service: MewService
Wersion: 1.0.0
Default prosy:

Default subprogram:

Description: & brief description of the business service,
= Method List = Method Information

This section lists the This section describes method information.
methods used by this

business service. Method nare: methodl

Default MMethod descripkion:
methodl

Method prosey:
Method subprogram;
MMethod steplib:

Crverview | BML

By default, method1 is displayed in Method name.

Type the name of the new method over the default name in Method name.

Type a brief description of the method in Method description.

b
2

Type the name of the subprogram that implements this method in Method subprogram.
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| Note: You do not need to specify a method step library unless the default step library

associated with the business service/domain is not sufficient.

Test the Business Service and Subprograms
For information on testing business services and subprograms, see Application Testing.
Use the Dependencies View

When a business services resource (for example, a business service, domain, steplib, business

service unit test) is open in the editor view, the Dependencies view displays dependencies between
that resource and other business services resources and/or Natural resources. This section describes
the nodes contributed to the view by business service resources. The following topics are covered:

= Business Service Resources
= Natural Subprogram Resources

] Notes:

1. Select 1% to sort the resources alphabetically.
2. Select 4 to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>" is displayed with the name of the resource. If the unknown module(s)
is not shipped with the Construct runtime project, either manually download it from the server
or create it locally. If the module(s) is shipped with the Construct runtime project, add the
project. For information, see the Natural ONE Code Generation guide.

4. For more information about the Dependencies view, see the description of the source editor
in Using Natural ONE.

Business Service Resources

When a business service is open in the editor view, the root node displays the name of the business

service, as well as the name of the domain in which it is located. In caller mode (=), the child
nodes display the name of each business service resource that depends on this business service.
In the following example, the business service resource that depends on the Calculator.v1.1.1
business service in the DEMO domain is a business service unit test named Calculator:
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?—E Dependencies &2 o | ®g | %[ ed T 8

=l [ DEMC: Caleulatar. vl 1.1
g Calculator

In callee mode (=), the child nodes display the names of the business service resources that the
parent node depends on. In the following example, the Calculator.v.1.1.1 business service in the
DEMO domain depends on a domain named DEMO and two subprograms named CALC and
CALCY in the DEMOTEST library:

?—E Dependencies &3 o | e |%[&ed T8

= |G DEMO:Calculakor. vl 1.1
+- B DEMOTEST CALCY
8k DEMOTEST CALC

Natural Subprogram Resources

When a Natural subprogram is open in the editor view, the root node displays the name of the

subprogram, as well as the name of the library in which it is located. In caller mode ( “z)), a business
service child node will be displayed for each business service that depends on this subprogram.
In the following example, the Calculator.v1.1.1 business service in the DEMO domain depends
on the CALCY subprogram in the DEMOTEST library:

?—E Dependencies &3 = S |Y%|l%ed T O

= | DEMOTEST:CALCY
+-[ 47 DEMO: Calculator vl 1.1

In callee mode ("), no child nodes are displayed because subprograms do not depend on any
business service resources.

Add Business Service Definitions to CentraSite

You can register business services and their corresponding metadata with CentraSite using the
Add to CentraSite wizard.

| Note: This wizard is an optional feature for NaturalONE and is only available when the
CentraSite plug-ins are installed. To install CentraSite, refer to the CentraSite documentation.

This section covers the following topics:

= |mport the Business Service Asset Types
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= Add Business Service Metadata to CentraSite
= Verify Metadata was Added to CentraSite

Import the Business Service Asset Types

Before you can add business service definitions to CentraSite, you must import the business service
asset types to the CentraSite server.

» To import the business service asset types:

1  Select Import on the File menu.

The Import window is displayed.
2 Select CentraSite > Archive.

For example:

7= Im port

Select

Zhoose import source, 'E -

Select an impart source:

bype filker bext |

= General

== CentraSite
(1, Archive
i BPEL
5, repart
18], Schema

2 Cancel

3 Search for and select the Natural ONE install folder \eclipse\v34\ plugins \ com.softwareag.natur-
alone.gen.nbs.eclipse.version \res \ com.softwareag.naturalone.gen.nbs.centrasite_asset_types.zip file.

] Note: The version number above may change.

4 Select Finish to import the asset types file.

J Note: For more information on importing a file, see the CentraSite documentation.
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Add Business Service Metadata to CentraSite

This section describes how to add the business service metadata to CentraSite.

» To add business service metadata to CentraSite:

1 Open the context menu for the business service in the Navigator view.

You can add the metadata for all business services defined in a NaturalONE project or for
any folder or object within the project, depending on which business services node is selected
in the Navigator view. For example, if you select the Business-Services root node, the metadata
for everything defined in the project will be added to CentraSite. If you select an object or
folder within the Business-Services root node, only this object or folder (and any items
within the folder) will be added.

2  Select Business-Services > Add to CentraSite.

The Add Business Service Metadata to CentraSite panel is displayed. For example:

7= Add Metadata To CentraSite M =3
Add Business Service Metadata to CentraSite >
Enter details about the Centrasite connection,
e -
Connection details
Server: | |
User ID: | |
Password: | |
€] Finish l [ Cancel

3  Type the CentraSite connection path in Server.

4  Type the user credentials for CentraSite in User ID and Password.

¢ Tip: You can set up the default Server and User ID values in the Preferences window
for CentraSite. For information, see Set CentraSite Preferences.

84 Business Services



Creating a New Business Service

5  Select Finish.
The business service definition will be added to CentraSite and the wizard will close.

| Note: If there are any problems, check the Error view for information.

Verify Metadata was Added to CentraSite

» To confirm that metadata has been added to CentraSite:

1  Select Open Perspective > Other on the Window menu.

The Open Perspective window is displayed.
2 Select CentraSite > Search and Browse.

3  Select the Asset Types view.

If necessary, select < to refresh the view.

4  Select an NBS asset type.

For example, select NBS Service:

2 My CentraSit Q‘Q‘ o @C? Administratio E—? Repository E 'E:@ Reqistry Expl

o [

&[] O

[] [Zl EsB Document Type
P @ESB Package

[] = ESE Service

P f) ESE Specification
[] S"EsB W5 Descriptor
D 5 JDEC Datasource
[ [z] Matural Library

[ [2] Matural Subprogram
[] [z] MBS Domain .
2] MBS Service

[ [z MBS Steplib

O] E Portlet I

5  Select # to update the list in the Contents view.

For example:
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02 contents 52 . [ZE Documentsw & Seardﬂ & Ul g T 0O
Aszets
Browse by: |[None] vl
Mame Description Status
':::' DEMO. Calculator.w1. 1.1 Performs simple calculator funct...  submitted
£ 1UDDI Inquiry Services Web Service supporting UDDI L.,  submitted
DD Custody and Ownershi,..  Web Service providing partial s...  submitted
£ 1UDDI Publish API Services Web Service supporting UDDILP...  submitted
£ UDDI Security Service Web Service supporting UDDI 5...  submitted

¢ Tip: Todisplay a graphical impact analysis, open the context menu for an object in the

Contents view.

6  Select the business service that you added to CentraSite.
The Summary page is displayed. For example:
=4
Summary
MBS Service () DEMO.Calculator. v1,1,1
« Details
Mame: DEMO. Calculator.w1. 1.1
Type: MBS Service
Description: Performs simple calculator functions. In addition a success flag is set if the solution is areater than the
success criteria, Additional information,
w Classified by
@ Category @ Taxonomy

{http:/inamespaces softwareag.com/nb...  ObjectType
« References

Association Type Object

HasParent ':::' DEMO
Lses () cac

+ Technical Properties
Owner: AME\SACAME

Status Stability Expiration Major ¥e... = Minar Ve... Date Cr...

submitted dynamic 1 0 2009-10-...

Summar\;J General | Permissions | Object-Specific Properties | Associations | MES Metadata
7 Verify the associations in the References section.
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8  Select the NBS Metadata tab.

Additional information about the service is displayed. For example:

NBS Metadata

service_version: | 111

Summary |General |Permissions Object-Specific Properties | Assodations [NBS Metadata
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18 Generating a New Domain

This section describes how to generate a new domain into a NaturalONE project. The domain file
will be created locally.

] Note: You can upload the file to the server using standard NaturalONE functionality.

» To generate a new domain:

1 Open the context menu for the project.

2 Select Business-Services > New Domain.

The Define Domain Details panel is displayed, showing the name of the project. For example:
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= i e
= New Domain E |||:I|&|
Define Domain Details g
Enter the information needed to generate a new business service domain.
[ -
Matural project name: | MewProject | [Browse... ]

Domain details

Marne: | |

Description: | |

Steplib: | w |

7 Cancel

] Note: If this is not the project into which you want to generate the domain, select Browse
to choose a different Natural ONE project.

3  Type the name of the domain in Name.

| Note: The wizard will check the server connection to verify whether the domain cur-

rently exists. If it does, a message is displayed. You can either overwrite the existing
domain or enter a new name.

4  Type a brief description of the domain in Description.
5  Select the steplib in Steplib.

By default, the steplib name is the same as the domain name.

6  Select Finish to generate the domain file (and possibly the associated steplib file).

The generated items are added to your Natural ONE project and the new domain is now listed
in the Navigator view. For example:
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U7 MNavigator 0 =8
== 1=
= Lvé MewProject-=daef.hg.5a0-7307 (1)
= .settings
== Business-Services
== _steplibs
E MEWDOM,steplib
== NEWDOM

©

(& Matural-Libraries
\=| .natural
|X] .project

| Note: The generated steplib file is also displayed (see NEWDOM.steplib in the example

above).

7 Open the domain to display details in the editor view.

For example:

B MEWDOM,steplib [ .domain 22 =0

Cverview

+ General Information
This section describes general information about this domain,

Domain: MEW DM

Descripkion: | My nev domain |

Skeplib chain: | MEWDCM vl

Orvverviess | XML

8  Save the domain file.
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19

Generating a New Steplib

This section describes how to generate a new steplib into a NaturalONE project. The steplib file
will be created locally.

» To generate a new steplib:

1
2

Open the context menu for the project.

Select Business-Services > New Steplib.

The Define Steplib Details panel is displayed, showing the name of the project. For example:

7= New Steplib

Steplib details

Define Steplib Details *
Enter the information needed to generate a new business service steplib,
. -
Matural project name: | MewProject | lBerse... l
Mame: | NEW_STEPLIE] |
Copy Matural Security skeplib definitions
| Browse. ..
Finish l [ Zancel
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3  Type the name of the steplib in Name.

| Note: If the steplib currently exists, a message will be displayed.

Optionally, you can:

Task

Procedure

Select another NaturalONE
project into which to generate
the steplib.

Type the name of the project in Project or select Browse to display a
window listing the existing projects for selection. The project must
currently exist.

Retrieve the steplib definitions
for a secured library.

Type the name of the library in Natural library or select Browse to
choose the library from a list of available libraries.

Note:

1. If you specify a secure project and a library, the steplib definitions
in the specified library will be copied; if you specify a non-secure
project, the steplib definitions associated with the project will be
copied.

2. This option is only available when Natural Security is installed.

4  Select Finish to generate the steplib file.

The generated items are added to your Natural ONE project and the new steplib is now listed
in the Navigator view. For example:

T Wavigatar 3 =8
| % 1'%: =
=2 MNewProject- >daef.hg.sag-7307 (1)
+[= ,settings
== Business-Servicas
=I-[= _steplibs

=l rEW STEPLIR. steplib
E MEWDOM,steplib
+- = MEWDOM
+-[E Matural-Libraries

.natural

X| .project

Open the steplib file to display details in the editor view. For example:
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E: WEW_STEPLIE.steplib 52 =B

Overview

= General Information
This section describes general information about this skeplib chain,

Steplib: MEW _STEPLIE

+ Library List
This section lists the step libraries within this steplib chain,

MEWLIE
DEMOTEST
SYSTEM
C53RT

Remawve

p

Diown

Crverview | BML

| Note: By default, the settings defined in Properties > Natural > Steplibs on the context
menu for the project are used as the default steplib chain.

5 Add step libraries to the steplib chain in Library List.

For information, see Add a Step Library to the Steplib Chain.
6  Save the steplib file.

| Note: You can upload the file to the server using standard NaturalONE functionality.
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20 Downloading Business Services from the Server

= Map to an Existing Natural Business Services Installation ..............cccccoiiiiiiiiiiiiiiii e 98
= Download Business Services Resources t0 a Local Project ...........cccvviiiiiiiiiiiiiiiccee e 99
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Downloading Business Services from the Server

This section describes how to download business services data from a Natural Business Services
installation on the server to the local environment. This procedure is performed in two parts: first
the Natural Server view is mapped to an existing business service installation on the server and

then the services are downloaded from Natural Server to the Navigator view.

This section covers the following topics:

| Note: All business service resources are stored in a local NaturalONE project. If you do not

want to use an existing project to store the downloaded resources, you can create a new

project. For information, see the NaturalONE documentation.

Map to an Existing Natural Business Services Installation

» To map to an existing Natural Business Services installation:

1 gelect =/on the toolbar in the Natural Server view.

The Map Environment panel is displayed. For example:

— ]
= Map Environment

Specify the mapping parameters For the Matural server,

Matural server connection
Host name: |
Port number:

Enwironment name:

Skartup
Session parameters:
User ID:

Password:

Map a Natural Server Environment ﬁ

@ Cancel

2 Type the name of the host in Host name.

3  Type the port number in Port number.

98
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The name of the environment is derived from the host and port values and displayed in En-
vironment name when you select the field.

Type a Natural profile name in Session parameters.

Type the user credentials for the server in User ID and Password.

Note: These credentials must be defined to Natural Business Services security and have

the correct permissions.

Select Finish.

The connection is displayed in the Natural Server view. For example:

=H Natural Server o - =H % | 0

= =H daef hq.sag-7307
#-[= Business-Services
+- = Construck
+-L[) User Libraries
+ C[] System Libraries
+- L) DDMs

Note: For more information about the Natural Server view, see the NaturalONE document-

ation.

Download Business Services Resources to a Local Project

» To download business services to your local project:

1

Open the context menu for the Business-Services root node.

Or:

Expand the root node and select one or more steplib and/or domain nodes or files using
standard selection techniques.

Note: Children of the selected nodes are automatically included in the download (for

example, selecting the Domains node will download all domains from the server).

Select Add to existing Project.

For example:
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=H atural Server 53 g | =5 % =0
= = daef.hqg.sag-7307
BRESYELsiness-Services o ap
= Steplibs
= Domains P Add to existing Project. .,
= Construct
Cf User Libraries 2| Refresh F5
Systern Librari
C{ system Libraries Eroperties
CH poms

A list of available projects is displayed.

3 Select the project into which you want to download the business service data.

For example:

- = ] ] = = |
= Add Business services resources to existing project |- |®

Select Project:

1= ConstructRuntime
I;'NvNewProject
L';—NfSampleProject

@j [0] 9 l [ Cancel

4  Select OK.

A progress window is displayed as the business service data is downloaded from the Natural
Server view to the local project in the Navigator view.

The definitions for all selected services, domains, and steplibs are added to the specified project.
Any supporting business service resource that was not selected will be automatically downloaded
depending on the user preference value (for example, the supporting steplib for a selected domain
will be downloaded if the user preference value is set to true). To view the downloaded resources,
expand the Project name >Business-Services node in the Navigator view. For example:
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U7 MNavigator 0 — AE Y S0
= 13' MNewProject-=natural-runtine
+[= ,settings
== Business-Servicas
#-[= _steplibs
== DEMD
.. domain

[ Caloulator, vl 1.1.bsry

E’-_T] Calculatorddvance.w1.1.1,bsry

[ Customer.v1.1.1.bsrv

E’-_T] CustorerCreditAnalysis.v1.1.1.bsry
[ CustomertwithContactDaka, vl 1,1, bsry
E’-_T] CustomneriwithContactDaka, w2, 1.1, bsry
|_—@ ErrorMessageTesting. v1.1,1 bsry

E’-_T] FlipString.wi.1.1.bsry

|_—@ GreatestCommonDenominator.»1,1.1.bsry
E’-_T] Orderwl.1.1.bsry

[0 Order.vz.1.1.bsrv

E’-_T] Product.wl.1.1.bsry

|_—@ StringManipulation.»1.1.1.bsry

E’-_T] Warehouse vl 1.1.bsry

|_—@ narravBaseballPlavers.w1.1.1.bary

ity

Download Additional Libraries (Optional)

This section describes how to determine whether any libraries are missing and then download
the additional libraries from the server.

» To download additional libraries from the server:

1 Open the _steplibs > StepTibName.steplib file in the Navigator view.

The steplib editor is displayed. For example:
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E DEMO.steplib 532 =8

Cverview

+ General Information
This section describes general information about this steplib chain.

Steplib: CEMO

 Library List
This section lisks the skep libraries within this
steplib chain,

DEMOTEST
V3

Co3RT Remove
C53P4
53
553
Sys53 T
SYSMATC

=

Cvverviess | XML

| Note: For more information about the steplib editor, see Define the Steplib Chain In-
formation.

2 Review the Library List for any step libraries that are not available locally (i.e., not listed in
the Navigator view).

In this example, the DEMOTEST step library is not available.
3 Open the context menu for the missing library in the Natural Server view.

4  Select Add to existing Project.

For example:
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= o
=M Matural Server &3 -l | = S

=?: Map

% &dd to new Project
“ add to existing Project

=| Copy
¥ Delete
Rename
Mave...

2| Refresh

I Unlock,

Predick Description and Generation

i Matural Engineer

Properties

Chrl+C
Delete
Fz

| Note: You can also select Add to new Project to create a new NaturalONE project into

which you can download the library. For information about creating a project, see the

NaturalONE documentation.

The selected library is downloaded from the server to the specified NaturalONE project and
is now available in the Navigator view. For example:

T Mavigator &3 =0
R AB T
= = MNewProject-=daef.hg.sag-7323 (1)
+ = ,setkings
=l[=+ Business-Services
== _steplibs
E DEMO.steplib
+-[& DEMO
ER = DEMOTEST
Wzl natural

NEl project

Business Services
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Perform Standard Actions on Business Service Resources

You can use the Natural Server view to copy/paste, delete, or move business service resources on
the server. The action will be performed in the mapped environment for the selected node(s).

| Note: Although you can select resources from more than one Business-Services node, you

cannot select nodes from different mapped environments.
This section covers the following topics:

= Perform Actions on a Business Service
= Perform Actions on a Domain
= Perform Actions on a Steplib

Perform Actions on a Business Service

» To perform actions on one or more business services:

1 Open the context menu for the business service(s) in the Natural Server view.

For example:

=H Matural Server £4 = | =§ = =0
= ":E daef.hg.sag-7307
=I-[= Business-3ervices
4= Steplibs
== Domains
=, DEMO

o) —alculator (1.1.1)
E’-_T] Calculatorfdyvance
|_—@ Customer (1.1,1) E‘_T] Add to existing Project., .
E’-_T] CustornerCreditan

=:E Map

|_—@ CustomerithiCon Mawe...
[ CustomerithCon E=) oPY Chrl+C
|_—@ ErrorMessageTest ¥ Delete Delete
[ Flipstring (1.1.1) .

Properties

|_—@ GreatestCommonk
[ order (1.1.13

[0 Order (2.1.1)

[ Product {1.1.1)
|_—@ StringManipulation {1.1.1)
E’-_T] Warehouse (1.1.1)

|_—@ narravBaseballPlavers {1.1.1)

2 Select one of the actions listed.

The available actions are:
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Action |Description

Move |Removes the selected business service(s) from the current domain and adds the service(s) to
a target domain in the mapped environment for the selected node. For information, see Move

a Business Service.

Copy |Copies the selected business service(s) to the clipboard in anticipation of a Paste action. For
information, see Copy a Business Service.

Delete | Removes the selected business service(s) from the current domain. For information, see Delete

a Business Service.

Move a Business Service

» To move one or more business services:

This section describes how to move one or more business services from the current domain to a
target domain in the mapped environment for a selected node(s).

Open the context menu for the business service(s) in the Natural Server view.

Select Move.

The Move Objects window is displayed. For example:

7= Move Ob jects &l

Choose destination For Calculator (1.1.1):

+ =l 1BMz.hq.sag-7323

Zancel

This window lists the connection nodes for the available mapped environments.

Expand the connection node for the environment into which you want to move the service(s).

Select the Domains root node into which you want to move the service(s).

Select OK.

A progress window is displayed while the service(s) is removed from the previous Domains

node and copied to the selected Domains node.

Business Services
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Copy a Business Service

This section describes how to copy one or more business services to the clipboard and then paste
the service(s) into a target domain.

» To copy one or more business services:

1
2
3
4

Open the context menu for the business service(s) in the Natural Server view.
Select Copy.
Open the context menu for the Domains root node into which you want to copy the service(s).

Select Paste.

The service(s) is copied to the selected Domains root node.

Delete a Business Service

This section describes how to remove one or more business services from the current domain.

» To delete one or more business services:

Open the context menu for the business service(s) in the Natural Server view.

Select Delete.

A confirmation window is displayed to confirm the action.

Select Yes.

The service(s) is removed from the Domains root node in the current mapped environment.

Perform Actions on a Domain

Typically, the only action available for a domain is Delete, which removes one or more domains
from the current mapped environment.

» To remove one or more domains from the server:

1

Open the context menu for the domain in the Natural Server view.

For example:

106

Business Services



Downloading Business Services from the Server

":E Matural Server 23 = | =8 =0
= ":E daef .hg.sag-7307
== Business-Services

4= Steplibs
== Domains
. Ege] —
=H Map
[y Add to existing Project...
¥ Delete Delete
2| Refresh FS
Properties

| Note: The Paste action is only available when the clipboard contains one or more

business services. For information, see Copy a Business Service.

2 Select Delete.

A confirmation window is displayed to confirm the action.

3  Select Yes.

The selected domain(s) is removed from the Domains root node in the current mapped envir-
onment.

Perform Actions on a Steplib

The only action available for a steplib is Delete, which removes one or more steplibs from the
current mapped environment.

» To remove one or more steplibs from the server:

1 Open the context menu for the steplib in the Natural Server view.

For example:
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L] o —+l, =
=H Natural Server &2 =] | =0 S =

= '-’JT: daef .hg.sag-7307
=I[=+ Business-Services
== Steplibs
E DEMO =
=H
E pEmol
[E |__@ Add ko exisking Project. ..

Map

3 Delete Delete

Properties

2  Select Delete.

A confirmation window is displayed to confirm the action.

3  Select Yes.

The steplib(s) is removed from the Steplibs root node in the current mapped environment.
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Editing Information about an Existing Business Service

This section describes how to edit the information for an existing business service. The business
service editors allow you to see and edit all the information for a business service.

| Note: You cannot change the key fields, such as the file or domain names.

This section covers following topics:

Edit the Business Service Definition

» To edit the business service definition:

1  Open the ExistingService.bsrv file in the Navigator view.

The business service editor is displayed.

2 Select a method in the Method List section.

The Method Information section is displayed. For example:
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Calculator.wl.1.1.bsry 23
Cverview

w General Information

This section describes general information about this business service,

Domain:
Service:
Version:

Default pros:

Default subprogram:

Descripkion:

w Method List
This section lisks the methods

used by this business service,

Divide
DEFALLT
Tulkiply
Subbract

Orvverviess | XML

DEMO
Zalculator
1.1.1

CALCY
CALC

A brief description of the business service,

+ Method Information
This section describes method information,

Method name: Add
Method descripkion:

Method prosy:
Method subprogram:
Method steplibs

3  Edit information about the service.

Using the editor, you can:

Task

Procedure

Change the name of the subprogram proxy used | Type the name of the proxy in Default proxy.
for this service.

Change the name of the subprogram that Type the name of the subprogram in Default
implements the service methods. subprogram.

Change the description of the business service. | Type the description in Description.

Add a service method.

See Add a Method.

Remove a service method.

Select the method in the Methods List section and
select Remove.

Change details about a method. Select the method in the Methods List section and

change the details in the Method Information section.

Business Services
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4  Save the business service.

| Note: You can upload the business service file to the server using standard Natural ONE
functionality.

Edit the Domain Definition

» To edit the domain definition:

1  Expand the domain node in the Navigator view.

2 Open the .domain file for the business service.

The domain editor is displayed. For example:

.. domain &8 =8

Overview

w General Information
This section describes general information about this domain,

Domain: DEMO

Description: | Demo domain

Steplib chain: | DEMO w

Cvverviess | XML

3  Edit information about the domain.

Using this editor, you can:

Task Procedure

Change or provide a description of the domain. Type a description of the domain in
Description.

Change the default name of the steplib chain (list of Type or select the name of the steplib chain

libraries that includes the step library containing the in Steplib.

subprogram that implements the service method).

4  Save the domain.

] Notes:
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1. You can upload the domain file to the server using standard NaturalONE functionality.

2. For more information on domains, see Defining Steplibs and Domains, Natural Business Services
Administration.

Edit the Steplib Definition

» To edit the steplib definition:

1 Expand the steplibs node in the Navigator view.
2 Open the SteplibName.steplib file for the business service.

The steplib editor is displayed.

3  Select a step library in the Library List section.

Information about that library is displayed. For example:

= DEMO.steplb 53 =8

Overview

w General Information
This section describes general information about this steplib chain,

Steplib: DEMO
w Library List w Library Information

This section lists the step libraries within this This section describes library information,
steplib chain,

Library name: | DEMOTEST
Library DBID: | O

Library FMR: | O

Cvverviess | XML

| Note: The DBID and FNR values are not required; they are only used in advanced
configurations when uploading to the server.

4  Edit information about the steplib chain and step libraries used for the business service.
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Using this editor, you can:

Task Procedure

Add a step library to the steplib chain.  |See Add a Step Library to the Steplib Chain.

Note: For information on creating a new step library, see

Create a Step Library.

Remove a step library from the steplib  |Select the library in the Library List section and then select
chain. Remove.

Reorder the list of step libraries within the|Select Up and Down to reorder the list.
steplib chain.

Change the name of a step library. Select the library in the Library List section and change the
library name in the Library Information section.

| Note: The DBID and FNR values are not required; they are only used in advanced
configurations when uploading to the server.

5  Save the steplib file.

] Notes:

1. You can upload the steplib file to the server using standard NaturalONE functionality.

2. For more information on steplib chains, see Defining Steplibs and Domains, Natural Business Services
Administration.
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After creating business services locally, or downloading them from an existing server installation,
you can create Java clients and/or Web services for the services. This section covers the following
topics:

Generate a Java Client

Using the Generate Java Client wizard, you can develop Java client applications that access Nat-
ural Business Services server components via dynamic RPC. The wizard creates Java clients from
Natural Business Services objects in a Natural ONE project and then generates the Java client inter-
face objects used by the Java client to access the server components.

» To generate a Java client:

1  Open the context menu for the business service in the Navigator view (i.e., the BusinessSer-
viceName.bsrv file).

2 Select Generate Java Client.

The Configure Generated Class panel is displayed. For example:

¥= Generate Java Client |Z|@|E|

Configure Generated Class

Enter the desired project settings and parameters For the class to be generated

FE

The generated class will be based on Calculator,wl. 1.1, bsry service:
Project Parameters

Source folder: | FampleProject

Package name: Browse. .,

[]=enerate Web Service {.aar) File

Web Service

[#] Generate JUnit test file
[Jredesign the interfaces

@j Finish l l Cancel

Using this panel, you can:
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Task Procedure

Generate a Web service file (file with a .aar extension). |Select Generate Web Service (.aar) file. The
Web service file will be created when the class
is generated.

Deploy the generated Web service to a WS-Stack See Deploy a Generated Web Service.
runtime environment.

Suppress the generation of a JUnit test file containing |Deselect Generate JUnit test file.
test functions that correspond to each method in the

business service. Note: For a description of the JUnit test file,

see Test the Java Class.

Redesign the interface for Natural subprograms, such |See Redesign the Interface.
as changing the default IDL directions or selecting
which portions of a redefined field to use.

Type the name of the source folder in Source folder or select Browse to browse for a folder.

If you select a project as the source folder, the wizard will automatically create and use
<projectname>[Java/src as the source folder. In addition, the wizard will set the output/com-
pilation folder to the bin folder corresponding to the source. For example, if the source folder
is set to Java/src, then the output/compilation folder will be set to Java/bin.

| Note: The folder must currently exist.

Type the name of the package in Package name or select Browse to browse for a package.

The package does not have to currently exist.

Select Finish to generate the Java class.

The class and associated files are displayed in the Navigator view. For example:

TS Mawigator 2 ==

= L':fi CompanyDema
+ [ .setkings
+[ Business-Services
BRI 1ava
=[5 srC
=l [=% Calculator
[} CalculatorData.java
E-_} CalculatorService. java
[} CalculatorServiceTest, java
D nbs.properties
== lib
2 lag4i-1.2.15.jar
@ wrappercore. jar

In this example, the following items were generated in the Calculator node:
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Iltem Generated

Description

Calculator node in src

Java package.

CalculatorData.java

Java class containing the PDA for the business service, which is mapped to
Java. This class has the same name as the business service and a suffix of
"Data".

CalculatorService.java

Java class containing the code that communicates with the business service,
as well as the Add method. This class has the same name as the business
service and a suffix of "Service".

CalculatorServiceTest.java

JUnit class with the same name as the CalculatorService.java class and a
suffix of "Test". For more information, see Test the Java Class.

Note: This file is only generated when the Generate JUnit test file option

is selected.

nbs.properties file

A .properties file for the business service. For more information, see Set the
nbs.properties File to Run a Dynamic RPC Java Class.

log4j-1.2.15.jar file in lib

Library containing the logging functionality.

wrappercore.jar file in lib

Library containing the helper classes and functionality for the generated
Java class.

The business service class is displayed in the editor view. For example:

nbs.properties m CalculatorServiceTest, java m CalculatorService.java &3 =0
1 Epackage Calculator; ~
Z
F*¥import org.apache.logd].Logger;[]
13
14 public class CalculatorService extends Abstractlerwvice |
15
16 private Logger _logger = Logger.getLogger(this.getClass()):
17
15 fEE
19 * Creates a service and sets the Broker RPC settings based upon the NE3Zettings class
z0 * BrokerException
21 e
22 public Calculator3ervice () throws BrokerException {
23 super () ;
24 ¥
zZ5
26 public Calculator3ervice (Broker broker, String brokerZervice) |
27 super (hroker, brokerZ3ervice):
Z8 ¥
9
30 public Calculator3ervice (String brokerID, String hroker3ervice,
31 String userID, 3tring password) throws BrokerException
3z super (hrokerID, brokerZervice, userIDh, password):
33 ¥
34
35 public CalculatorData.CalcClass.CaleClassResult _default
3G CalculatorData. CaleClass. InputDataClass inputdataclass,
37 CalculatorData. CaleClass. OutputbataClass outputdataclass) '

To display the JUnit class, select the CalculatorServiceTest.java tab. For example:
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nbs.properties

Z

Z-import java.net.URL;

4 import java.util.Enumeration;

5

& import org.apache. logdj.BasicConfigurator;

7 import org.apache. logd].LogManager;

5 import org.apache.logd]j.Logger;

2 import org.apache.logd].PropertyConfigurator:

10 import org.junit.lssert:

11 import org.junit.BeforeClass:

12 import org.junit.Test;

13

14 public class CalculatorZerviceTest |

15

165 [{BeforeClass

17 public static void beforeCalculator3erviceTest ()
15 if (lisLogdiConfigured()) |

19 /4 Attempt to find log4j.properties file.
Z0

z1 URL url = CalculatorierviceTest.class
z2 .getResource ("logdj.properties™™) ;
23 if (url == null)] {

4 BazsicConfigurator. configurel();

Z5 } else {

Z6 PropertyConfigurator.configurefurl) ;
27 ¥

Z8 ¥

] Note: This file is only generated when the Generate JUnit test file option is selected.

m CalculatorServiceTest. java &4 m CalculatorService java

ffIf log4j.properties file can not be found then use the BasicConfigurator to configure loggd]

1 package Calculator;

{

If it is found then load it.

| >

| £

To display the properties file for the business service, select the nbs.properties tab. For example:

nbs.properties £3

1# ISample nbs.properties file
NEZSettings class to load Broker RPC connection settings.
to load this file using the following search order:
"nhs_properties” pointing to the file

"nhs_properties” pointing to the file

Zff This file iz used by the
3ff NE3Settings will attempt
4% 1) Jawva SysStem property
5# Z) Environment wvarishle

m CalculatorServiceTest, java m CalculatorService, java

6# 3) MNE3Zettings'

7# 4) Context class loader
S# Hint: For AXISZ usage copy this file into the <tomcat:>/webapps/s<ws stack:/WEE-INF/classes folder

S# Warning: For security reasons, it is recomwended that the password not be set in this file.

104
11

class loader

It iz much more secure to set the Broker credentials programatically.

libroker.id=localhosc: 1971
1ibroker.service=RPC/3EV1/CALLNAT
l4user.id=FWRUSE

1Epasswvord=

This section covers the following topics:

Deploy a Generated Web Service
Redesign the Interface

Set the nbs.properties File to Run a Dynamic RPC Java Class
Use log4j Logging Statements in a Runtime Environment

Test the Java Class
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= Write an Application to Use the Generated Java Class

Deploy a Generated Web Service

This section describes how to deploy a generated Web service to a WS-Stack runtime environment.

| Note: To use this option, you must first select Generate Web Service (.aar) file on the

Configure Generated Class panel.

» To deploy a generated Web service:

1  Select Deploy the generated Web Service.
2 Select Next.

The Deploy NaturalONE Web Service panel is displayed. For example:

¥= Generate Java Client

Deploy NaturalOne Web Service

Please choose the desired destination,

- B

MName: | localhost-49951

Password: | LTI

vl

URL: | http:fflocalhost: 43981 jwsstack) sagdeplover |
Lser: | adrin |
|

':':’:' Finish l[ Zancel ]

This panel displays the default parameters for the WS-Stack runtime environment running
in the default Tomcat servlet engine. The default user credentials are also displayed (these

can be changed at first logon).

4  Confirm the user credentials.

5  Select Finish.

Confirm the name and location of the WS-Stack runtime environment.
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For more information on deploying a Web service or changing logon credentials, refer to the
Web Services Stack documentation.

Redesign the Interface

This section describes how to redesign the interface generated for a Java client.

» To redesign the interface:

1  Select Redesign the interfaces on the Configure Generated Class panel.

2  Select Next.

The Design Interface for Natural Subprogram panel is displayed. For example:

T= Generate Java Client |:|®
-

Design Interface for Natural Subprogram
=

Set IM, OUT, INOUT directions, seleck REDEFIMEs and suppress parameters to design the interface. You can use the contesct menu, Quick Fix or
buttons,

Matural Parameters BSTRINGN =) IDL Library DEMOTEST =)

S 1 #E17-INPUT-OUTRUTS
75

G+ 1 #BIZ-0OUTPUTS

B 4" BSTRINGH
45 #BIZ-INPUT-OUTPUTS  InCut
Map to Out -> 8 #BIZ-OUTRUTS Inout

MaptoIn-=

Map ko Induk -

SUppress

w Matural Subprogram Source BSTRINGN
Eﬁ Source

68 * out all customizations in this exit as well a5 the MOVE-TCO and MOVE-BACK L
2% exits and it will recreate these exits based on the current specifications.
o

e 0z FLIP3ITRA-E1

73E 03 INFUT-STRING [AS0)

i 03 REWVERIED-3ITRING (AS0)

73 02 C3ALCASE-EL

76 03 INPUTS

Er 04 #FUNCTICH (A1)

78 03 INFUT-OUTPUTS v

@j Finish l [ Cancel

The upper left pane on this panel displays the parameters for the Natural subprogram and
allows you to select operations (for example, Map to In, Map to Out, Map to InOut, or Sup-
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press). The upper right pane displays the IDL directions that will be inserted as top-level
parameters (level 1) in the interface definition for the Natural subprogram. The bottom pane
is used for reference purposes; it displays the Natural subprogram source and its PDA sources,
each in a separate tab.

¢ Tip: To reserve more space for viewing the upper panes, you can close the bottom pane

when it is not needed.

Using this panel, you can:

Task Procedure

Define the direction of parameters in the interface. See Define the Direction of Parameters.

Select which portions of redefined fields in the PDA to use. |See Select Portions of Redefined Fields.

Hide or suppress unneeded parameters in the interface. See Suppress Parameters.

Select Finish.

If you selected multiple Natural subprograms, you can now redesign the next interface. The

current and total number of subprograms designed so far is indicated in the title (for example,
2/3).

Note: For more information about using this panel, refer to the EntireX documentation.

Define the Direction of Parameters

This section describes how to change the default IDL directions for the generated Java client.

» To define the direction of parameters:

1 Expand the INPUT-OUTPUT and OUTPUT nodes in the upper left pane of the Design Inter-
face for Natural Subprogram panel.
For example:
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7= Generate Java Client

Design Interface for Natural Subprogram -
Set IM, QUT, INOUT directions, select REDEFINES and suppress parameters ko design the interface. You can use the context menu, Quick Fix
of buttans,

Matural Parameters BSTRINGN = IDL Library DEMOTEST =

Al | #EIZ-INPUT-CUTPUTS

Map to In -= = 4" BSTRINGN
B g5 2 CIACASE-EL = 48 #BIZ-INPUT-OUTPUTS  InOuk
= E&; 3 INPUT-CUTPUTS Map ko Out - = @G CSACASE-EL
i B 4 #STRING (A100) =] = % INPUT-0UTPUTS
S g2 4 REDEFRMIE #5TRIG &F #sTRING (A100)
5 DVPLAT-STRING (450 #F STRING-LENGTH (12)

Map ko InCwuk -=

5 REVER SED-5TRING (4507 Suppress - 4% #BIZ-QUTPUTS  InOut
GEt 3 STRING-LENGTH (12) - 4% C5ASTD-EL
- g2 1 #BIZ-0UTPUTS = &% cuTPUTS
B g5 2 CansTO-EL P mse (879
B 25 3 ouTPUTS &F MsG-HR. (M4)

%t 4 M5G (AT9) P Msc-DaTA (83203
TEL 4 MSG-MR (N4) 47 RETURN-CODE (A1)
95 4 MIG-DATA (A3211:3) &7 ERROR-FIELD (A32)
%5 4 RETURN-CODE (A1) +F ERROR-FIELD-INDE®L (P3)
% 4 ERROR-FIELD (A32) 7 ERROR-FIELD-INDE®2 (P3)
&L 4 ERROR-FIELD-INDEX1 (P3) " ERROR-FIELD-INDE®3 (P3)

%! 4 ERROR-FIELD-INDEX2 (P3)
%! 4 ERROR-FIELD-INDEXS (P3)

+ Matural Subprogram Source BSTRINGN
Fﬂa; Source

1£/]%

7z 02 FLIPETRR-E1

@ Fish | [ cancel

| Note: Natural parameters that are mapped in the interface are marked with a green

circle.

2 Open the context menu for the first level 1 parameter you want to define.

3 Select one of the following options:

" Map toIn
" Map to Out
® Map to InOut (the default direction, if no other direction is specified)

The operation is reflected in the IDL Library pane.
4  Continue defining level 1 parameters as desired.

5  Select Finish.
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Select Portions of Redefined Fields

This section describes how to select which parameters redefined in the Natural PDA are used in
the interface.

» To define which portions of a redefined field to use:

1 Expand the INPUT-OUTPUT and OUTPUT nodes in the upper left pane of the Design Inter-
face for Natural Subprogram panel.

For example:

= Generate Java Client

Design Interface for Natural Subprogram -
Set IN,OUT, INOUT directions, select REDEFIMEs and suppress parameters to design the interface, You can use the context menu, Quick Fix or *
buttons,

Matural Parameters BSTRINGN =] IDL Library DEMOTEST [=]
= g5 1 #B1Z-INPUT-OUTPUTS = " BSTRINGN
B 25 2 CncASE-E1 - 4% #BIZ-INPUT-OUTPUTS  InOut
B 25 3 INPUT-OUTPUTS - 4% CsacasE-EL
& REL 4 #5TRING (AL00 =| enrors = 4F meuT-oUTRUTS
=& =ty 7 #3TRING (ALOD)
5 ICLAT-STRING (4 50) @p STRIMG-LEMGTH (I}
5 REVERSED-STRIVG (4507 45 #BIZ-OUTPUTS InOut
%Er 3 STRING-LENGTH (I2)
&5 1 #B1Z-0UTPUTS
+ Matwural Subprogram Source BSTRINGN
Ea Saurce
JiE 04 #FUNCTICN (A1) 5
75 03 INPUT-OUTRUTS
79 04 #3ITRING (4100)
80 .
g1 * 05 #CHAR (Al1/1:100)
gz 05 INPUT-3TRING (A50) /% from FLIFSTRA-E1
a3 05 REVERSED-STRING (AS0) /* from FLIPSTRAL-E1
54 03 STRIMNG-LENGTH [I2)
a5 01 #BIZ-OUTPUTS
i3 0z C3A3STD-E1
a7 a3 OUTFRUTS v
@) Finish l ’ Cancel

Redefined fields are identified by the #* icon.
2 Open the context menu for the REDEFINE base parameter or any REDEFINE path.
3  Select Map to InOut.
4  Select Finish.
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Suppress Parameters

This section describes how to suppress unnecessary parameters, which creates a less cluttered IDL
client interface and minimizes the amount of data transferred at runtime.

» To suppress parameters in the interface:

1  Open the context menu for the parameter in the upper left pane.
2 Select Suppress.
3  Select Finish.

Natural parameters suppressed in the interface are displayed in italic type.
Set the nbs.properties File to Run a Dynamic RPC Java Class

You can set the nbs.properties file to run a dynamic RPC Java class. The settings to run the Java
class are loaded by the NBSSettings class. This class will try to find the nbs.properties file using the
following search order:

1. nbs_properties Java system property pointing to the file

2. nbs_properties environment variable pointing to the file

3. class loader for NBSSettings

4. class loader for context for current thread

The entries in the nbs.properties file are:

Setting Description Default

broker.id Broker connection ID. localhost:1971
broker.service |Broker service endpoint. RPC/SRV1/CALLNAT
user.id User ID to use with Broker. |GUEST

password Password to use with Broker. |blank/empty string

For example:

broker.id=BKR13003:4010
broker.service=RPC/NBS53DEV/CALLNAT
user.id=PWRUSR

password=

| Note: If the generated code will be used in AXIS2, you must copy the nbs.properties file to
the <WebApp>/classes folder.

@ Caution: For security reasons, it is recommended that the password not be set in the

nbs.properties file. It is much more secure to set the Broker credentials programmatically.
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Define Different User IDs and Passwords for Web Services

Both the user. id and password properties can use a Java class suffix (for example, package.MySer-
vice), which allows the client to use different user IDs and passwords for different services and/or
groups of services. For example:

user.id.package.name.MyService=USERIDA
password.package.name.MyService-PWDA
user.id.package.name=USERIDB
password.package.name=PWDB
user.id=PWRUSR

password=

When the MyService Web service in the package.name Java package is invoked, the USERIDA user
ID and PWDA will be used. When any other service within the package . name Java package is invoked,
the USERIDB user ID and PWDB password will be used. All other services will use the PWRUSR user
ID and no password.

Use log4j Logging Statements in a Runtime Environment

The generated Java classes support log4j logging statements for advanced diagnostics at runtime.
If logging is being used, there is the potential for data to be visible in the log files produced in the
runtime environment. To avoid this problem, configure the com.softwareag.naturalone.gen.dy-
namicrpc.core logger file to only display warnings and above. For example:

log4j.logger.com.softwareag.naturalone.gen.dynamicrpc.core=WARN
Test the Java Class

When you select Generate JUnit test file on the Configure Generated Class panel before gener-
ating the class, a JUnit class is also generated. This class contains test functions that correspond to
each method in the business service. For example:

@Test
public void testAdd() throws Exception {
Calculator service = createService();
CalculatorData data = new CalculatorData();
//T0ODO populate data
CalculatorData result = service.add(data);
Assert.assertNotNull("Result is null", result);
//T0D0 check result
}

//TODO comments have been added in the source to indicate where additional information is
added for the test. By default, the test succeeds if no errors occur during the call to the business
service and if data is returned.

Data can be added before the service method is invoked. For example:
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//TODO populate data
data.getCalcInput_data().set_first_num(new BigDecimal(2));
data.getCalclInput_data().set_second_num(new BigDecimal(2));

In addition, an assert clause can be included to verify that the result is correct. For example:

//T0D0 check result
Assert.assertEquals(new BigDecimal(4),
result.getCalcOutput_data().get_result());

Tests can be invoked using standard Eclipse JUnit functionality (i.e., run as Junit test). The envir-
onment for the test is contained in this function in the test file. For example:

private Broker createBroker() throws BrokerException {
String userID = "GUEST";
String password = "";
Broker broker =
new Broker(Demotest.DEFAULT_BROKERID, userID,
Demotest.DEFAULT_SERVER);
broker.logon(password) ;
return broker;
}

Write an Application to Use the Generated Java Class

After generating a Java class, you can write an application that uses the class to invoke a business
service. Use the following code as a template for writing the application; read the comments for
additional information:

// Create the EntireX Broker object

Broker b = new Broker("localhost:1971","GUEST");

// Create the service class.

Calculator calcservice = new Calculator(b, "RPC/SRV1/CALLNAT");
// Create the service data class

CalculatorData calcdata = new CalculatorData();

// Set input values for the call
calcdata.getCalclnput_data().set_first_num(new BigDecimal(2));
calcdata.getCalcInput_data().set_second_num(new BigDecimal(2));
calcdata.getCalcInput_data().set_function("Add");

// Invoke a service method, passing in the data class

// make sure to catch any errors that might happen.
CalculatorData calcresult = null;
try {

calcresult = calcservice.add(calcdata);

} catch (DataException e) ({

e.printStackTrace();

} catch (BrokerException e) {

e.printStackTrace();

} catch (ServiceException e) |

e.printStackTrace();

}
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// Examine the result
System.out.printin("Result is:"
+ calcresult.getCalcOutput_data().get_result());

Generate a Web Service

Using the Generate Java Client wizard, you can generate a Web service from business service
object in a NaturalONE project. The generated Web service objects are WS-Stack Web service
archive files (files with a .aar extension) and can be deployed in a Web services Stack runtime en-
vironment and registered in CentraSite. Web service client applications can then access these Web
services and expose business logic implemented by the Natural server components.

» To generate a Web service:

1 Open the context menu for the business service in the Navigator view (i.e., the BusinessSer-
viceName.bsrv file).

2  Select Generate Web Service.

The Configure Generated Class panel is displayed. For example:

7= Generate Java Client IZI[EIEI

Configure Generated Class

Enter the desired project settings and parameters For the class to be generated

=
e::‘l

The generated class will be based on Calculatar.w1.1.1.bsry service:
Project Pararneters

Source folder: | MewProject

Package name: | MewPackage Browse, .,

Generake Web Service {,aar) file
Web Service
Deploy the generated Web Service
[ IRedgister the generated and deploved Web Service

Generate JUnit kesk File
[JRedesign the interfaces

'A?' Mext = l I Finish ] [ Cancel

e

Using this panel, you can:
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4

Task

Procedure

Change the source folder in which to generate
the Java class.

Type the name of the source folder in Source folder or
select Browse to browse for an existing project. The
folder must currently exist.

Change the name of the Java package or select
another package.

Type the name of the Java package in Package name
or select Browse to browse for an existing package. The
package does not have to currently exist.

Suppress the deployment of the generated
Web service to a WS-Stack runtime
environment.

Deselect Deploy the generated Web Service.

Register the Web service after it has been
generated and deployed.

Select Register the generated and deployed Web
Service.

Note: To select this option, Deploy the generated Web

Service must also be selected.

Suppress the generation of a JUnit test file
containing test functions that correspond to
each method in the business service.

Deselect Generate JUnit test file.

Note: For a description of the JUnit test file, see Test
the Java Class.

Select Next.

The Deploy NaturalONE Web Service panel is displayed. For a description of this panel, see

Deploy a Generated Web Service.

Select Finish to generate the Java class for the Web service.

Configure the Web Service to Use WS-Security

All generated services extend "com.softwareag.naturalone.gen.dynamicrpc.core. AbstractService".
The default constructor for the generated service determines which Broker credentials to use based
on the following rules:

1. When WS-Security is turned on and the credentials are passed in the SOAP header, they will
be used in the call to Broker.

2. In all other cases, the settings in the nbs.properties file will be used. For information, see Set the
nbs.properties File to Run a Dynamic RPC Java Class.

» To configure a Web service to use WS-Security:

1
2

Open the context menu for a business service in the Navigator view.

Select Generate Web Service.

The Configure Generated Class panel is displayed. For example:

Business Services
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V= Generate Java Client

Configure Generated Class

Enter the desired project settings and parameters for the dass to be generated

The generated class will be based on Caloulator w11, 1 bsry service:
Prajeck Parameters

Source folder: | ewProjeck | [Browse... ]

Package name: | MewPackage | [Browse... ]

Generate Web Service [.aar) file
Wehb Service
Deploy the generated Web Service
[]Reqister the generated and deploved Web Service

Generate Jnit kest File
[ ]redesign the intetfaces

@:‘ Mesck = ] I Firish ] [ Cancel

3  Deselect Deploy the generated Web Service.
4  Select Finish.

The generated Web service files are displayed in the Navigator view. For example:

T Mavigakor 53 =8
=3
= ConstructRuntime-=natural-runtime (13
'[é natdocStandardPdas- =natural-runtime (1)
-l MewProject- =daef hg.sag-7307 (7)
= .settings
= .msstack
[ Business-Services
= Conskruct
== Java
= bin
=i sre
== NewPackage
m CalculatorData, java
B calculatorService, aar
m CalculatarService, java
4] CalculatorServiceTest, java
nbs.properties

5  Open the generated .aar file in the editor view.

6  Select the Services tab.
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7  Select Enable WS-Security in the Modules section.

The settings in the Security section are displayed. For example:

= . =
== *CalculstorService.aar £ 8

Service: | CalculatorService v

w Description - Properties
Press the Set button ko confirm your changes or Clear to remowve the

description. Mame Walue

web Service CalculatorService et ServiceClass HewPackage. CalculatorService

Clear

* Message Recelvers

* Transports
Add, edit or remave additional Message Receivers

COnrte

Class Mame Message Exchange Pattern HTTPS
org.apache. axis2.rpc.receivers. RPCMessageReceiver hitkpe ffwee . w3, orgf 200408 wsdlfin-out Cltce
s
~ Modules ~ Palicies

Choose "Save as..." to save the user defined policy as a policy file,

[JEnable Ws-ReliableMessaging  Inactivity Timeaut Miliseconds Avallable Policies: | UserDefined | |Save Policy as...

Enable W5-Security

* Security
() no Binding () Message-level Security with Symmetric Binding [use Client: Certificate
*) Transport-level Security with 550 () Message-level Security with Asymmetric Bindin Enable Secure Conversation
(@ Transp ¥ g ¥ i g
Message-level Security Options Token Assertions
[Jsign Header []Encrypt Body [user Mame Taken
[OsignBody  []Include Timestamp [1x.509 Cartificate

Security Model Configuration Encrypt,/Sign message part

Keystare: ¥Path Expression Enct... Sign Add...

Keyshore Password:
Signing Certificate Alias:

Encryption Certificate Alias:

User:
Fassword Callback Class: v
Policy validator Calback Class: w

Archive | Services | Operations | Services.xml

8  Select the following settings.
* no Binding

® User Name Token (in the Token Assertions group).

9  Save the changes to the .aar file.
10  Open the context menu for the .aar file.

11 Select Web Service Stack > Deploy Web Services Package.

The Deploy Your Web Services panel is displayed. For a description of this panel, see Deploy
a Generated Web Service.

On the client, the following SOAP header must be included with the correct credentials specified:
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<soapenvlZ2:Envelope xmlns:soapenvl2="http://www.w3.0rg/2003/05/soap-envelope">

<{soapenvlZ2:Header>
<wsse:Security xmlns:soapencl2="http://www.w3.0rg/2003/05/soap-encoding"”

xmins:xsd="http://www.w3.0rg/2001/XMLSchema" <
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

«
xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/0asis-200401-wss-wssecurity-secext-1.0.xsd"

>
<wsse:UsernameToken>
<wsse:Username>MyUser</wsse:Username>

<wsse:Password>MyPassword</wsse:Password>
</wsse:UsernameToken>
</wsse:Security>
</soapenvl?2:Header>
<soapenvlZ2:Body>

Note: Since user credentials will be included in the SOAP header, it is highly recommended
that you use HTTPS. For instructions on how to configure AXIS2 to use HTTPS, refer to the

AXIS2 documentation.
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Set Business Service Preferences

You can set preferences for the Business Services component in the Preferences window for

Business Services.

» To set preferences for the Business Services component:

1 Select Preferences on the Window menu.

The Preferences window is displayed.

2  Select Software AG > Business Services.

The Business Services settings are displayed. For example:

7= Preferences |Z|@@
w

General
Ank
Centrasite
[Daka Managermnent
Help
Instal/Update
Java
Jawa EE
Jawa Persistence
JawaScript
Plug-in Development
Report Design
RunfDebug
Server
Software AG

Ajax Developer

L e e e e

#

Code Generation
Construck
Entirel

Makural

R

Request Document
Testing
UDDI Registries

Team
Walidation
Wb

Wb Services
#ML

&

[

(=
ey

Predict Description and Generation

Web Jervices Stack

Business Services 4= o
General settings for Business Service resources.,

Generation settings

Check For existing resource on Matural server

“When generating a resource, the supporting resources can also be generated if they don't exist locally,
[¥] Buto generate supporting resources by downloading From Matural server (g, domain, steplib

[¥] Auto generate supporting resources using defaulk values

Download setkings
Check For existing resource locally

“When downloading a resource, the supporting resources can also be downloaded when they don't exist
locally {not a recursive download),

[#] Auto download supporting resources from Makural server

Upload settings

“When uploading a resource, any supporting resource that would cause the abnormal termination of the
upload process can also be uploaded when it does naot exist on the server.

[ Auto upload supparting resources

[Restore Defaults] [ Apply

l

[ K, ] ’ Cancel

]

Using this window, you can:
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3

Set CentraSite Preferences

Option

Description

Check for existing resource on
Natural server

When this option is selected, the code generator will check the
Natural server for the existence of the business service resource being
generated and display a warning message if it exists.

Auto generate supporting
resources by downloading from
Natural server (e.g. domain,
steplib)

When this option is selected, the code generator will automatically
download supporting resources, such as the domain and/or steplib
files, from the Natural server if they do not exist locally.

Auto generate supporting
resources using default values

When this option is selected, the code generator will automatically
generate the supporting resources, such as the domain and/or steplib
file, using default values if the resources do not exist locally.

Note: This option only applies when Auto generate supporting

resources by downloading from Natural server is not selected, or
is selected but the resource does not exist on the Natural server.

Check for existing resource
locally

When this option is selected, the code generator will determine
whether the selected business service resource(s) exists locally. If it
does, a warning message will be displayed.

Auto download supporting
resources from Natural server

When this option is selected, the code generator will automatically
download the supporting resources from the Natural server if they
do not exist locally.

Auto upload supporting
resources

When this option is selected, the code generator will automatically
upload dependent resources, such as the domain file, if they do not
exist on the Natural server.

Note: This option eliminates server exceptions that can prevent the

selected resources from being uploaded to the server.

Select OK to save the preferences.

You can set up default values for the CentraSite connection in the Preferences window for
CentraSite. These values will be filled in automatically when the Add Metadata to CentraSite
wizard is displayed.

» To set CentraSite preferences:

1

2

Select Preferences on the Window menu.

The Preferences window is displayed.

Select Software AG > Business Services > CentraSite.
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N G = W

=
& Preferences

General
Ank
CentrasSite
[ata Managenent
Help
InstallUpdate
Java
Jawva EE
Java Persistence
JavaScript
Plug-in Development
Repoart Design
Run/Debug
Server
Software AG
Ajax Developer
[=I- Business Services
Cenkrasite
Installation
Code Generation
Conskruck
Entirex
Matural
Predict Description and Generation
Request Document
Testing
LDDI Reqistries
‘Web Services Stack
Teamn
validation
Web
Web Services
AML

) B B e ) ) B B B -

[ B

#

Rl

)

The Preferences window for CentraSite is displayed. For example:

CentraSite

General settings for adding metadata to Centrasite.
Server settings

Server: |

Uset It |

Organization: |

[Restore Defaulks ] [ Apply ]

l

Ok

] [ Cancel ]

Type the CentraSite connection path in Server.
Type the user identification for CentraSite in User ID.
Type the name of the organization in Organization.

Select OK to save the preferences.

The Server and User ID values will now be provided on the Add Business Service Metadata
to CentraSite panel when it is displayed.
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Set Installation Preferences

To function properly, certain UI functions require a Business Services installation on the Natural
server. For example, the Business-Services root node in the Natural Server view can be used to
download Business Services resources from a Natural server to a local Natural project, but only
when there is a Business Services installation on the server. By default, these UI functions will be
made visible based on the installation of Business Services on the Natural server. To accomplish
this, a server call determines which products are installed on the server and the results are cached
until Designer shuts down, which allows for only one server call per host | port|session parameter.

You can set installation preferences in the Preferences window for Business Services Installation.

» To set installation preferences:

1  Select Preferences on the Window menu.

The Preferences window is displayed.

2 Select Software AG > Business Services > Installation.

The Preferences window for Installation options is displayed. For example:
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-
= Preferences

Java EE

Java Persistence

JawaScripk

Flug-in Development

Report Design

RunfDebug

Server

(=) Software &G

Ajax Developer

Business Services
Centrasite

i

Installation

Code Generation
Construct
Entirex
Makural
Predict Description and Generation
Request Document
Tesking
UDDI Registries
Web Services Stack
Teamn
Yalidation
“Web
Web Services
AML

e

@

| Installation L b
General
At General settings For Business Services installation,
Centradite
Data Managemenk Server installation
Help Some UL functionality (e.q. conkext menus, Maktural Server view nodes, ete.) requires a Business Services inskallation
InstallfUpdate on the Matural server to Function propetly.
Java IMake UI Functionality visible based on product installation on the Matural server

[ Restore Defaults ] [ Apply ]

l QK H Cancel ]

Using this window, you can:

Task

Procedure

Make all Ul functions visible, even when
Business Services is not installed on the
Natural server.

Deselect Make Ul functionality visible based on Natural
server installation. No server calls will be made to
determine which products are installed on the server.

Select OK to save the preferences.
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Security for business services is applied at the domain level by associating a group with a domain.
Access can then be granted or denied at a domain, business service, and/or method level. When
you select the Business Services root node or a domain node in either the Navigator or Natural
Server view, details about the current security settings are displayed in the NBS Security view.

This section covers the following topics:

] Note: For more information on defining security, see Server Security Overview in Natural

Business Services Administration.

Activate the NBS Security View

By default, the NBS Security view is not available.

» To activate the NBS Security view:

1 Select Show View > Other on the Window menu.

The Show View window is displayed. For example:

= Show View

= 2
[= lava Browsing

(= Javascript

= lavaServer Faces

(=5 JhE-WS

[= Ira

= Plug-in Developrient

= Report and Chart Design
= Repart Design

= Server

[ Software AG

(= Software A Entiren

[ Saoftware AG MaturalOMNE
= Team

= EML

Zancel

2 Select Software AG NaturalONE > NBS Security.

For example:
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= Show View

= Software AG
== Software AG Entire
=-[= Software 4G NaturalOME
?—g Dependencies
E Layout Painter Protacol
2 NaTdoc
-'-’:a Makural Server
el 165 Security

Pradict Report
Report Data
E RTL Visual Order
&_] Server Logs Yiewer
9 Time Stamp Conflicts
“I5 Unlock Objects
= Team

ril Predict Description and Generation

OF.

I

Cancel

3  Select OK.

The NBS Security view is displayed.

] Note: If you reset the perspective, you must re-activate the NBS Security view.

Define Security for a Domain

» To define security for a domain:

1  Expand the Business Services root node in either the Navigator or Natural Server view.

The list of available domains is displayed.

2 Select the domain you want to secure.

The NBS Security view displays security details about the groups within the domain. For

example:
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= Properties |[3) MBS Security (DEMO domain) 3

Group [ Mame Disable = Grant  Rewvoke
+ ADMIN =]
+ DEMOUSRS =]
# DEVS =]
# USERS =]

To display the business services within a group, expand the group name. For example:

=] Properties | 4] MBS Security (DEMO domain) &2

Group | Mame Disable = Grant  Rewvoke

= ADMIN =] =]

¥

T E R FFEFEEEEF

¥

+ DEMOISRS
+ DEWS
4 |JSERS

CustomerZreditinalysis w1.1.1
FlipString +1.1.1

Customer v1.1.1
CuskomerwithContackData v1.1.
Order w1.1.1

Order w2,1.1

Product +v1.1.1

‘Warehouse v1.1.1
ErrarMessageTesting vw1.1.1
GreatestCommonCenominatar w1
Calculator wi1.1.1
Calculatoradvance w1.1.1
SkringManipulation v1.1.1
rarravBaseballPlayers w1.1.1
CuskomerwithContackData v2.1.

RIRIRE

To display the methods defined for a service, expand the business service node. For example:

= Properties | (3] MBS Security (DEMO domain) &3

Group | Mame Disable | Grant = Revoke

= ADMIN ] =]

+

+

+

CustamerCreditinalysis w1.1.1
DELETE
EXISTS
FORMER.
GET
IMNITIALIZE
MEXT
STORE
UPDATE
FlipSkring +1.1.1
Custorner v1.1.1
CustomerWithContackDats w11,

= e
L

VI:IE
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3  Select a security option at the group, service, or method level.

The security options are:

Security Option | Description

Disable Temporarily revokes access to a group, service, or method. When the group, service,
or method is enabled, the previous settings are restored.

Grant Allows access to the corresponding group.

Revoke Disallows access to the corresponding group.

4 Open the context menu for the group, service, or method and select Update.

For example:

] Properties | (5] MBS Security (DEMO domain] 53 o™ O35 - ¥ =0
Group | Mame Disable = Grant  Rewvoke
E1_ADMIN _— |
DEMOLSRS
DEVS % add group...
USERS 3 Delete group
> o Into

Or:
Select the group, service, or method and select the 6 toolbar option.

A progress window is displayed as the security settings are updated on the server.
Toolbar Options

The following toolbar options are available in the NBS Security view:

Toolbar Icon | Description

i Updates the security settings on the server.
i Displays a window to add a group to the current domain. See Add a Security Group.
= Synchronizes the domain details in the NBS Security view based on which domain is currently

selected in the Navigator view. For example, if this option is on (as in the example) and you
select a different domain in the Navigator view, the details for the new domain are displayed

in the NBS Security view. If this option is off (%) and you select a different domain, the details
in the view do not change.
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Toolbar Icon

Description

Tip: As it may take some time to retrieve security details from the server, you can turn this

option off when you do not require these details.

Add a Security Group

You can also use the NBS Security view to add a group to a domain.

» To add a group to a domain:

1  Open the context menu for one of the groups listed in the NBS Security view.

2 Select Add group.

Or:

Select one of the groups and select the I toolbar option.

The Security Groups window is displayed. For example:

7= Security Groups

Select a security group to add to the DEMO domain,

ADMIN

CaT
DEMCUSRS
DEWS
MNOMRESTRICT
RESTRICT
USERS
VEADDIN

OF ] [ Cancel

3 Select the group you want to add.
4  Select OK.

The group is added to the domain.
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Delete a Security Group

You can also use the NBS Security view to remove a group from a domain.

» To delete (remove) a group from a domain:

1 Open the context menu for the group in the NBS Security view.

2 Select Delete group.

The group is removed from the domain.

Business Services 145



146



	Business Services
	Table of Contents
	Preface
	I Release Notes
	1 What's New in Version 8.2.1
	Enhancements
	Java Client Generation
	Natural Server View
	Security View

	Known Issues
	Option to Move Business Services between Domains
	Support for Redefined Fields
	Java Client Generation when PDA Fields Contain Direction Modifier Comments


	2 What's New in Version 8.2.2
	Enhancements
	Perform Actions on Business Service Resources
	Redesign the Interface during Java Client Generation


	3 What's New in Version 8.2.3
	4 What's New in Version 8.2.4
	Enhancements
	New Preferences for Business Services
	Support for WS-Security in Generated Java Code
	Run a Dynamic RPC Java Class


	5 What's New in Version 8.2.5
	Enhancements
	Changes to the Test Editors
	Changes to the Steplib Wizard When Natural Security is Installed


	6 What's New in Version 8.2.6
	7 What's New in Version 8.2.7

	II What is the Business Service Component
	8 What is the Business Service Component

	III 
	9 Before You Start
	10 Setting Up a Natural Business Services Environment
	11 Setting Up a Test Environment

	IV Getting Started
	12 Creating a New Business Service
	Create a Natural Project
	Create a New Library
	Access the Business Services Functions
	Generate the New Service
	Edit the Default Domain Information
	Edit the Default Steplib Information


	13 Generating a New Steplib
	14 Generating a New Domain
	15 Downloading Business Services from the Server
	16 Testing a Business Service

	V Service Development
	17 Creating a New Business Service
	Create a NaturalONE Project
	Create the Business Service
	Generate the Business Service
	Define the Domain Information
	Define the Steplib Chain Information
	Create a Step Library
	Add a Step Library to the Steplib Chain
	Create the Subprogram to Implement a Method
	Add a Method
	Test the Business Service and Subprograms
	Use the Dependencies View
	Business Service Resources
	Natural Subprogram Resources


	Add Business Service Definitions to CentraSite
	Import the Business Service Asset Types
	Add Business Service Metadata to CentraSite
	Verify Metadata was Added to CentraSite


	18 Generating a New Domain
	19 Generating a New Steplib
	20 Downloading Business Services from the Server
	Map to an Existing Natural Business Services Installation
	Download Business Services Resources to a Local Project
	Download Additional Libraries (Optional)
	Perform Standard Actions on Business Service Resources
	Perform Actions on a Business Service
	Move a Business Service
	Copy a Business Service
	Delete a Business Service

	Perform Actions on a Domain
	Perform Actions on a Steplib


	21 Editing Information about an Existing Business Service
	Edit the Business Service Definition
	Edit the Domain Definition
	Edit the Steplib Definition

	22 Generating Java Clients and Web Services
	Generate a Java Client
	Deploy a Generated Web Service
	Redesign the Interface
	Define the Direction of Parameters
	Select Portions of Redefined Fields
	Suppress Parameters

	Set the nbs.properties File to Run a Dynamic RPC Java Class
	Define Different User IDs and Passwords for Web Services

	Use log4j Logging Statements in a Runtime Environment
	Test the Java Class
	Write an Application to Use the Generated Java Class

	Generate a Web Service
	Configure the Web Service to Use WS-Security


	23 Setting Preferences for Business Services
	Set Business Service Preferences
	Set CentraSite Preferences
	Set Installation Preferences

	24 Setting Security Privileges
	Activate the NBS Security View
	Define Security for a Domain
	Toolbar Options

	Add a Security Group
	Delete a Security Group



